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Introduction

About the Integration

The IBM® Rational® Synergy for Eclipse Interface gives you change management support through insulated
and build management work areas, provides task-based configuration management (CM) support, and
supports source code control operations on project files directly from Eclipse™. This integration lets you
control and set up your Eclipse projects in Synergy.

Assumptions

Before using this document, you should have a basic understanding of how to use Eclipse and Synergy. If
you are unfamiliar with Eclipse, you should go through the tutorial and online help of Eclipse.

For more information about Eclipse, refer to: http://ww. ecl i pse. org/

You should also have a conceptual and practical understanding of Synergy. You should understand task-
based CM and be able to perform developer or build manager operations.

If you need more information about Synergy, refer to the following documentation, which is available on the
Synergy support web site:
http://publib.boulder.ibmconminfocenter/rsdp/vlr0OnD/index.]jsp

e For terms, concepts, and methodology, refer to the Introduction to Synergy.
e Forinformation about build management-level operations, refer to the Build Manager’s Guide.
e For a description of Synergy dialog boxes, commands, and default settings, refer to the Synergy Help.

You should read this entire document before using the integration. Knowing all of the features before you
integrate your data will help ensure a seamless, efficient integration.

Features

The integration lets you use the source code control and task-based CM operations from the Eclipse
development IDE. You can configure the integration to use multiple Synergy databases.

Refer to Conversion Process for Eclipse 1.0 Projects if you want to see instructions about the
conversion process for Eclipse 1.0 projects.

How the Integration Works

Eclipse provides a Team programming interface that allows repository providers to develop plug-ins and
expose their version control operations inside Eclipse IDE. This integration is available in the form of a set of
plug-ins and provides most common and advanced Synergy operations.

The Integration can connect to multiple Synergy databases using Synergy Connections. A Synergy
Connection uniquely represents a Synergy database. When you start a Synergy Connection, a
corresponding Synergy session is started. A Synergy Connection is required by the integration to be able
to connect to the Synergy database.

Users will need to customize their perspective to see the Synergy Task menu and Synergy Task toolbar.
Users may open the Synergy Console and Synergy Repository view.
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Alternatively, users can use IBM Rational Synergy Perspective, to open commonly used views required to
work in a team environment.

The Mylyn Task List and Task Repository views can be configured to connect to Synergy databases and
interact with Synergy tasks.

Audience

The IBM Rational Synergy for Eclipse Interface is for Eclipse developers.

Notices

© Copyright IBM Corporation 2005, 2009

U.S. Government Users Restricted Rights — Use, duplication, or disclosure restricted by GSA ASP Schedule
Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any reference to
an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or
service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM
intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify
the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send written
license inquiries to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS 1S”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
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exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street Cambridge,

Massachusetts 02142

US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results
obtained in other operating environments may vary significantly. Some measurements may have been made
on development-level systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on
the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

IBM, the IBM logo, ibm.com, Rational, Synergy, and Change are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries, or both. These and other
IBM trademarked terms are marked on their first occurrence in this information with the appropriate symbol
(® or ™), indicating US registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html.

Eclipse is a trademark of the Eclipse Foundation, Inc., in the United States, other countries, or both.

JDK, Java, JavaScript, Solaris, Sun, Sun Microsystems, OpenWindows, and all Java-based trademarks and
logos are trademarks or registered trademarks of Sun Microsystems, Inc., in the United States, other
countries, or both.

Other company, product or service names mentioned may be trademarks or service marks of others.

Page 8 of 87



IBM Rational Synergy for Eclipse Interface 4.2.0

What’s New?

This version of the integration includes the following changes.

e  This version provides compatibility with Mylyn 3.0.

Product Requirements

The following products are required to run the Synergy and Eclipse integration:

¢ |IBM® Rational® Synergy 6.5SP2, Synergy 6.6a, Synergy 7.0, or Synergy 7.1

e Eclipse 3.3, Eclipse 3.4, or Rational® Application Developer for Websphere® 7.5
e |IBM® Rational® Synergy for Eclipse Interface version 4.2.0

e |IBM® Rational® Change™ 5.0 or 5.1 (optional)

Installation Instructions

Install Synergy

Refer to the installation instructions for Synergy in the Synergy Installation Guide for Windows or the
Synergy Installation Guide for UNIX.

Install Eclipse

You can download Eclipse from http://www.eclipse.org/. Refer to the Installation instructions for
installation information.

Install the Integration

Follow the steps below to install the integration:

IBM Rational Update Site

1. Start Eclipse, go to Help->Software Updates->Find and Install...
2. Choose Search for new features to install and click Next.

3. Click New Remote Site and enter IBM Rational for the name and
http://download.boulder.ibm.com/ibmdl/export/pub/software/rational/telelogic/eclipse for the
URL.

4. Click OK, then click Finish.

Find IBM Rational Synergy for Eclipse Interface 4.2.0 in the list of available features and select
the checkbox.

Click Next.

Accept the license agreement and click Next.
Click Finish.

Click Install All.

10. When prompted to restart Eclipse, click Yes.

© © N>
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Local Installation

1.

No ok b

8.
9.
10.
1.
12.

Download the IBM Rational Synergy for Eclipse Interface 4.2.0. The integration is available in
the form of a zip file ec1ipse330 410.zip.

Unzip the zip file to a temporary directory.

Start Eclipse, go to Help->Software Updates->Find and Install...

Choose Search for new features to install and click Next

Click New Local Site and browse to the temporary directory where you unzipped the files.
Click OK, then Finish.

Find IBM Rational Synergy for Eclipse Interface 4.2.0 in the list of available features and select
the checkbox.

Click Next.

Accept the license agreement and click Next.
Click Finish.

Click Install All.

When prompted to restart Eclipse, click Yes.

Eclipse Customization

After you have successfully installed the integration, you may need to customize Eclipse to view the Synergy
drop-down toolbar and other views offered by the integration.

Open IBM Rational Synergy Perspective

A perspective defines the initial set and layout of views in the Workbench window. It provides a set of
capabilities aimed at accomplishing a specific type of task or working with specific types of resources. This
integration offers a perspective which opens and arranges views necessary to do Java™ development and
perform Team operations with Synergy.

To open this perspective, bring up Select Perspective dialog box as shown below. You can open this dialog
box from the Window menu, click Open Perspective, and then click Other.
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-

~ Open Perspective

\:jECII'S Fepository Exploring:
ﬁ Debug
(k& IBM Raational Syneray

-311 Java

E.J Java Browsing
TgJJava Type Hierarchy
== Plug-in Development
[*Resource (default)

EDTeam Synchronizing

Cancel

In the Select Perspective dialog box, select IBM Rational Synergy and click OK.

Make IBM Rational Synergy the Default Perspective

You can optionally make the Synergy perspective the default perspective. The Resource perspective is the
pre-defined default perspective. You can set the IBM Rational Synergy perspective to be the default
perspective.

To change the default perspective:

From the main menu bar, select Window > Preferences.
2. Expand the General category on the left and select Perspectives. The Perspectives preferences page
opens.

3. Select the perspective that you want to define as the default, and click Make Default. The default
indicator moves to the perspective that you selected.
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-

=]

= Preferences &
type filter text _ Perspectives o
= G;n:ral Open a new perspective
[#- Appearance ; ;
Capabilities (%) In the same window () In a new window
CompareFatch :
. Content Types Open a new view
[ Editors (%) Within the perspective () As fast view
- Keys
[#- Network Connections Open the assodated perspective when creating a new project
Perspectives (:} Always open '-’:‘.' Mever open {E} Prompt
Search
Startup and Shutdown Available perspectives:
Web Brow T - -
e qut:us Repository Exploring i Make Default |
i Welcome %D b = ;
ebug
[+ Workspace
- Ant lﬁJIEM Rational Synergy (default)
Cache §1Java
[+ Help @-,JJava Browsing
#- InstallUpdate 'E‘.' Java Type Hierarchy
#-Java = Plug-in Development
- Plug-in Development rﬁF‘.esouroe
- RunDebug gaTeam Synchronizing
[+ Team
Validation

- Web and XML
Mote: Reset takes effect the next time the perspective is opened

[ Restore Defaults ] [ Apply ]

(7 [ Ok ][ Cancel ]

4. Click OK.

If you have your own perspective and want to add the views offered by the integration, follow to the steps
below.

Activate Synergy Toolbar

1. Bring up the Customize Perspective dialog box.
2. Click the Commands tab.

3. Select the Synergy check box.
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£ Customize Perspective - Java |._| @| E|

Shortcutz  Commands
Select the command groups that you want to see added to the current perspective (Java). The details field identifies which
menu items andfor toalbar items are added to the perspective by the selected command group.
Available command groups: Menubar details: Toolbar detzils:

External Tools ~|[=-E syneray > == Synergy toolbar

Java Coding &, Select Task @ Wark Offline

Java Debug ¥| Create Task 2, Select Task

[ 1ava Editor Presentation #| Complete Task | Create Task

Java Element Creation -;ﬂ Show Task #| Complete Task

Java Navigation }ﬁ Checkout Project "’5"' Show Task

Java Open Actions - Open Project & Checkout Project

Java Search Jﬁ Show Synergy Eq'r Open Project

JUnit £ show Synergy

Keyboard Shortouts

Launch

Open Files

O rrofile

Resource Navigation

Search

Software Updates

DTeam

w
Use F2 to display the description for a selected command item.
0K | Cancel

4. Click OK.

Activate Synergy Repository View
1. Bring up the Show View dialog box.

2. Expand Synergy and select Synergy Repository.
3. Click OK.

Activate Synergy Task View
1. Bring up the Show View dialog box.

2. Expand Synergy and select Synergy Task.
3. Click OK.

Activate Synergy History View
1. Bring up the Show View dialog box.

2. Expand Synergy and select Synergy History.
3. Click OK.
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Activate Synergy Change Request View
1. Bring up the Show View dialog box.

2. Expand Synergy and select Synergy Change Request.
3. Click OK.

Activate Synergy Console View

The Synergy Console view is embedded in Eclipse’s basic Console view, as shown below.

Synergy History | Error Log  Problems % RA| 5 - =5

Synergy

The file c:/cmsynergy/usjowo/ccm wa/agincourt/eclipse int_connection-usjowo/eclipse_int_connection/notifier/CMDevClientCompl
The file

c:/cmsynergy/usjowo/ccm wa/agincourt/eclipse int connection-usjowo/eclipse int connection/notifier/CMDevClientTaskListener Z
is missing from Plugin's installation path. The integration will not function with Synergy for Dewvelolopers. Exit the IDE a

1. Bring up the Show View dialog box.
2. Expand Basic and select Console.
3. Click OK.

Project Setup and Data Migration

Before you start using the Integration, you must create a Synergy connection to connect to a Synergy
database. Refer to Create Synergy Connection section to learn how to create a connection.

Project setup and data migration are required before starting a project in Eclipse and controlling the same
under Synergy configuration management. This section describes this process.

Build your Application in Eclipse

Before you build your application in Eclipse, you must consider if your application has subprojects. Think of
all the subprojects in Eclipse as separate projects that have dependencies. You need to build all the
subprojects as Eclipse projects.

When the projects are built successfully, create .JAR files or any other files, you want. Add any other
external project files that you need. Your project is now ready for migration.

Migrate to Synergy

There are two ways to migrate projects to Synergy, one from Synergy, and the other from Eclipse. Both are
described below.

Migrate using Synergy

Refer to Synergy online help for project migration.
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Migrate from within Eclipse
This method can be used when you want to take advantage of the Ignored Resources option of Eclipse.

Use this option to specify the files that will be ignored during migration. These are the steps you need to
follow:

1. Use the Eclipse Preferences dialog box to specify resources to ignore. Click OK.

& Preferences |:IIEEI ]
type filter text - Ignored Resources T

+- General
Ant Use this page to spedfy a list of resource name patterns to excdude from version contral.

Help Ignore Patterns:

Install/Update & #|  Add Pattern...
Java g
Plug-in Development = BAK e =
Run,Debug 7
Team D *a
+ CVS * bak
File Content [ =bat

=
Ignored Resources D -com

Synergy

- - - F- 5

(]
=@
.II'I'I
¥l
am
=2
-
=a

EEEREEEEEER
T
;
#

5]
o
(]
"

RCSLOG
TAGS

o

| o

Q|
%]
=]
]
%]

W

Restore Defaults ‘ Apply J

CK | Cancel ‘

2. Bring up the Share Project wizard by right-clicking the project you want to migrate.
3. Select Synergy, then click Next to continue.

4. Click New Project if you want to create a new project; if not, select an existing project and its version.
Click Finish.
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& Share Project

Synergy

Select the project and project version
you want to connect to.

Connection Mame:

(training5_6

Working Projects: Project Versions:

newprojectdfs

newpraject
projects
testprojfds

Mew Project

(£ Mext = Finish ] [ Cancel

5.

If you click New Project, the following dialog box appears. Specify the project version, release and
other details, then click Create.
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e

Synergy

Create new project

Connection Mame: Releaze: | 1.0 ~ |

Project Mame: | test | Purpaose: |Insulated Development L |

Project Version: | 1 | Flatform: |.-5.ny V|

Description:

Default Task: 20; Task Twenty | [ Change Task

@ Create ” Cancel

6. The project will be added to Eclipse. Now, from the Team menu, use Add Uncontrolled Files to add
project files to Synergy.

7. Repeat the above steps for rest of the projects, if any.

Rebuild and Baseline Your Project

Your project is now in Synergy. Perform the following steps to baseline the project.
1.  Open Eclipse.

2. Now you need to get the Synergy project into Eclipse workspace. If you used the second method listed
above (Migrate from within Eclipse) to migrate the project, then you already have the project in your
workspace. If you used the first method (Migrate using Synergy) to migrate the project, then use the
Open Project wizard to get the project into your workspace.

3. Rebuild your application and . JAR files, etc.

4. You may be required to use the Synergy Classic Client to perform this. To baseline the project, you
must have the build_mgr role. If you don’t have this role, make sure all the tasks are checked in and
that no files in your Synergy project are checked out. Now you can ask your build manager or
administrator to baseline your project. Baseline projects are in a non-modifiable state, such as released,
integrate, etc.

For more information on project baselines, refer to the Synergy documentation.
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Setting Up a Development Project

You must have a working project to use for development work. Here are the steps needed to set up a

development project:
1. Start Eclipse.

2. On the Synergy toolbar, launch the Check Out Project wizard.

To check out a project, select the project, version, release, and task
Project page. You can optionally also specify work area.

& Check Out Synergy Project

in the project Check Out Synergy

Synergy

Select the project and project version
you want to check out.

Connection Mame: db3

Scope: |.-5.II demo's Waorking Projects w | Mew Version:

Projects: Project Versions:

test?

| demao |

[ ] also Chedk Out Subprojects

W

Release: | IJse Current Value Purpose;

Use Default Work Area

Insulated Development W

Wark Area: |

Default Task: | 2 asdf

| Select Task

Chedk Out H Cancel

4. Click Check Out.

The project will be checked out and added to your workspace.
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Release a project

A build management prep project is used to test and build the application. When the project is finished for a
particular release, the build manager transitions the prep project state to released state. This freezes the
project so that no further modifications can be made.

For details on build management, refer to the Synergy Build Manager’s Guide.

Getting Familiar with the Integration

This is a typical arrangement of different views in Eclipse. The figure below shows the different components
of the integration.

Label Decorators Synergy Toolbar Synergy Menu Synergy Change Request View Synergy Repository View
& Telelogi:: Synergy - testclassone. java - clipse SDK
Fie Edit Sgures Refactor Mavigate Search Jr
ro- Lle S E ] o A et Task =g b e -F - I | 6 Teleogic Syn *
-~ — | E CreateTask .
[ Padage Bxplorer £ . Mavigator ) Comelete Tosk Fds.java 1] tractest.jova D testass e jova X tory Bookmarks (]
=B P 7| ® showtak -
& .:,l ofafpf w c tProject pscclassone - u e 5_4 demo
= B newfrogect - 1 { rainngS_4) & OpenProjest @ My Project Groupings
= U8 fefault package) - 1 trainins5_4) 4 i # 8 Buld Management Project Groupings
# 10 fidstjova - 1 ) Show Symergy % ) Baselres Created in Last 30 Days
& T scffdsjova -2 T — @ My Projects
+ VL testclassone. java - 1 & 't rewproject-1
G-t troctest e - 1 5 W My Shared Projects
@ W\ RE System Lbrary [rel.6.0_03] 5 W ststic Projects
H S settings . N
(3 _sonmsidint # () trannss_S- demo
Yo doswath -1
Y3 .orogect -1
el ==
e & Synergy Change Request 1 =0
-
1
# (J wannss_s- demo
= (@ vannss_s- demo
= [B) My Assigned Change Requests
= B 5o
GetestS - 1.0
B sz
a0 [B My Change Requests Query (1)
My Change Requests Query
& Synergy Task 13 . Tasks =0
KRE: =
= (B vawss_ s deme .|
NONE
= |G my assgned tasks
Outine | & 52 Harachy =pm 1:Frst task - 1.0
3:5econd task - 1.0
4:Third task - 1.0
3 G:Fourth task - 1.0 a
& [rannss_4) c: e, 4 ctisdffds.java 1 . Problems =0
O 4 2
W Verson Owner Status Task Relasse CreatedOn  Irstance Type Commant
L demo ntegrate 38 10 28RS 1. 1 java Chacked n from Echoe
[ demo working 0 10 32708 3:0... 1 java
-
< £
o® Writable SmartInsert | 6:1
Synergy Console View Synergy History View Synergy Task View

Synergy Repository View

This is the view you use to manage Synergy Repository connections and browse Synergy projects. You can
use this view to open and check out projects as well.

All the working projects are grouped by project queries. A project query represents a set of similar projects.
The available project queries are described below:

Page 19 of 87



IBM Rational Synergy for Eclipse Interface 4.2.0

My Project Groupings:
This project query represents all working projects grouped by release tag.
Build Management Project Groupings:

This project query represents all build management projects grouped by release tag. A build management
project is typically in the prep state.

Baselines Created in Last 30 Days:

This project query represents all projects baselined in last 30 days. The projects are grouped by the name of
the baseline.

My projects:
This project query represents all working projects. The projects are not grouped.
My Shared Projects:

This project query represents all the working projects in shared state. The projects are not grouped.

Static Projects:

This project query represents all static projects. Projects are grouped by name of the project.

= Synergy Repository 32

= ﬁ db3-demo
5 My Project Groupings
--¥& 1.0 Insulated Development Projects
& test2-1
i test?-demo
¥ Build Management Project Groupings
=¥ Baselines Created in Last 30 Days
*,'Ei_} There are no baselines matching the spedfied creteria,
:
fa test2-1
Y& test2-demo
& test-1
My Shared Projects
Static Projects

The Synergy Repository view provides the following operations:

Create a Synergy Connection

The first time when you open a Synergy Repository View, you will see the following message:
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Bookmarks

h“;l You haven't added a Synergy Connection yet, Use context menu in Synergy Repository View to add a Connection.

A Synergy Connection is used by the integration to connect to the corresponding Synergy database. To
add a new Connection, you can use either the context menu or the toolbar button.

1. Click the toolbar button Create New Synergy Connection *ﬁ

or click the context menu New Connection.

2. The New Synergy Connection dialog box will appear. Enter the path where Synergy is installed on

your computer and click Next.

3. Specify the Connection Name and other information.

& New Synergy Connection

Synergy

Connection Mame;
User Mame:
Paszword:
Database Path:

Server:

Creates and validates a new Synergy Connection

| db2|

| demao

| Save

| \Wwm2\ccmdb70'\db2

|'-.rm2

Connect H Cancel

Click Connect.

4. If the password field is blank, enter your password in the following dialog box and click Start.
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& Synergy Connection

Synergy

Starts session for db2

Connection Mame:

LIser Mame:
Password:

Synergy Install Path:
Database Path:

Server:

| demo

| Wurn2Yocm 70

| \Wwm2\ccmdb70\db2

| vma

(2) Start l [ Cancel

5. Your connection will be added to the Synergy Repository View.

Notes:

1.  The name of the Synergy Connection is used by the integration to refer to the corresponding Synergy
database. The Synergy Connection name cannot be changed.

2. If you choose to save the password, your password will be encrypted and saved.

3. The Engine Host can by dynamically configured with an environment variable. The key stored within
this variable will be reloaded upon startup. The steps for setting the environment variable and using it as
a parameter are as follows:

For Windows

1. Open System in Control Panel.

2. On the Advanced tab, click Environment Variables, then click the name of the user variable or
system variable you want to change, as follows. Click:

- New to add a new variable name and value.
- Edit to change a current variable name and value.
- Delete to remove a variable name and value.

3. In the Synergy Connection dialog, enter $MY ENV_VAR% and click OK.
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For Linux

1. Forbash, ksh, and sh: export MY ENV_VAR=value
Forcsh: setenv MY ENV_VAR value
2. Inthe Synergy Connection dialog, enter $MY ENV_VAR in the Engine Host field and click OK.

Set a Connection as the Default

When you start working with the integration, you will be prompted to specify a Synergy Connection for
most of the operations. If you have only one Synergy Connection, or if you use one of the Synergy
Connections most frequently, it will be helpful to set this connection as default.

By setting a connection as default, you can avoid the step of specifying a Synergy Connection for many
operations.

In the Synergy Repository views:

1. Select the connection you want to make as default.
2. Right-click to bring up the context menu.

3. Click Set As Default.

4. This will make the selected connection the default, and the icon of the Connection will change to the
default connection icon.

Clear the Default Connection

To clear the default connection in the Synergy Repository view:

1. Select the connection from which you want to clear the default.
2. Right-click to bring up the context menu.

3. Click Clear Default.

4. This will clear the default connection and change the icon for the connection.

Modify a Synergy Connection

1. Select the connection you want to modify.
2. Right-click to bring up the context menu.

3. Click Properties.
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B(=1E3

Synergy i
Shows properties of Synergy Connection i
Connection Mame: | |
Iser Mame: | demo |
Password: | e | [save
Synergy Install Path: | WYum2Yccm 70 | Browse
Database Path: | YWm2Yocmdb 70db 2 |
Server: | vma |
@ Update | [ cancel

4. Click Update

Your changes will not take affect until Eclipse is restarted.

View/Modify Object Properties

You can view/modify properties of files and folders. If files/folders are not in the working state, you can only
view properties.

1. Select the connection where your project is located.
2. Expand the selected Synergy Connection and then select a project query.
3. Expand the project query to view available projects
4. Expand the project to view project’s files and folders.
Select a file or folder and right-click to bring up the context menu.

6. Click Properties. The Properties dialog for selected object will appear.
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& Properties

Synergy
Displays project/object properties

Basic Selection

Connection:  db3 Release: | N ~
Mame: test2

Status: working Platform: | Any "|
Owner: demo

Type: di

ype " Purpose:

Instance: 1

Created: 9/11/08 11:27 AM

Modified: 9/11/08 11:27 AM

Comment Task
2 Add
':':’:' Update H Cancel

Start a Synergy Connection

You can use the Synergy Repository View to start a Synergy session.
1. Select the connection you want to start.

2. Right-click to bring up the context menu.

3. Click Start

Note You don’t need to explicitly start a Synergy session. If you use the integration as you normally do, it will
automatically start the right session for you.

Open Projects

You can select one or more Synergy working or prep projects and open them into the Eclipse workspace.
You can not open static projects though.

1. Select the connection where your project is located.
2. Expand the selected Synergy Connection and then select a project query.

3. Expand the project query to view available projects
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4. Select a working project and right-click to bring up the context menu.
5. Click Open Project. The project will be added to your workspace.
Check Out Projects

You can select one or more Synergy projects and open them into the Eclipse workspace.

1.
2.

w

Select the connection where your project is located.
Expand the selected Synergy Connection and then select a project query.
Expand the project query to view available projects

Select a project and right-click to bring up the context menu.

Click Checkout Project to bring up project Check Out Synergy Project dialog box.

& Check Out Synergy Project

Synergy

Select the project and project version
you want to check out.

Connection Mame: dh3 A |
Scope: |.-5.II demao's Warking Projects L | Mew Version: | demol |
Projects: Project Versions:
testd
test 1
[ ] also Chedk Out Subprojects
Release: |L|SE Current Yalue % | Purpose: Insulated Development w
IUse Default Waork Area
Work Area: | | Browse

Default Task: | 2 asdf | Select Task

(£ Chedk Out H Cancel
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6. Specify the version, release, purpose, task, etc. and click Check Out.

Your project will be checked out and added to your workspace.

Stop Synergy Connection

You can use the Synergy Repository view to stop a Synergy session if you don’t need it any longer.
1. Select the connection you want to stop.
2. Right-click to bring up the context menu.
3. Click Stop. The corresponding Synergy session will be stopped.
Notes
1. If you exit from Eclipse, all the current Synergy sessions will be stopped automatically.

2. If you have many Synergy connections, running a Synergy session for all of them simultaneously
may consume lots of system resources. If you don’t often use a Synergy connection, you can stop
the Synergy session for it.

Delete a Synergy Connection

If you don’t need a Synergy connection any more, or you want to rename it, you can delete it.
1. Select the connection you want to delete.
2. Right-click to bring up the context menu.
3. Click Delete Synergy Connection.
4. You will receive a warning if this connection is being used.

5. Click Yes. The corresponding Synergy session will be stopped and your Connection will be
deleted. All the workspace projects connected to this Connection will be disconnected.

Show in History View

See How to see History of Objects

Compare with Predecessor

Use the Compare with predecessor function to compare the current version of the selected file or folder with
the last version, if it exists.

This will bring up a dialog similar to the following:
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Struckture Compare

@ Java Structure Compare

import org.

import com.
import com.
import com.
import com.
import com.
import com.
import com.
import com.

l.."ﬂ‘ﬂ‘
*
*

<

eclipse. jface.vizard. Wizardbialog:

continuus.errorapi.CemExceprion: import com.continuus.errorapi.ComExceptior
continuus.errorapi.CowlnvalidParam import com.continuus.errorapi.ComlnvalidP:
continuus.objectapi. Task: import com.telelogic.integration. wswh.CME7
telelogic.integration. wswh.CHMa3Team import com.telelogic.integration.wswb.hist
celelogic.integration. wswb.history import com.telelogic.integration. wswh.util
telelogic.integration.wswb.util.CH import com.telelogic.integration.wswh.wizs
telelogic.integration.wsub.viewvs. I
telelogic.integration. wswb . wizards S

o hsteele<hrs

*
bsteele<hr> ¥ This class serves as a wrapper for botl

* developer client, but can be switched 1

> < >

=gy workbench_ink = c™ CMapi ”~
= [Z4p SHC PBdo
—|- 224 com % B doConnectioniap
=[Sl telelogic 28 CMapilboolean)
=| - (=g inbegration 28 associateTaskToObjeck{String, String, String)
| [y wswh @& checkin(String, String, String)
=] 224 CMSESSIONS @8 checkin(String, String)
@Q pi. & checkinTask(String, String, String, String) “
£ >
|I] Jawa Source Compare E |<:|=>:| B 3| & i
CMApijava-7
~
import com.continuus.errorapi. ComException;
import com.continuus.errorapi.Comlnval idParsmeterException;
import com.telelogic.integration.wvswub.CM8TeamF lugin:
import com.telelogic.integration.wswb.hisctoryview.CHSHistorvyElement: .
Swnmi sk s sl s T mmrd s S e s mram e S o rrmrrls aae ST TIMTTE= 5 1 .
CMApi.java-+4 CMApijava-7.1.1

import org.eclipse.jface.wizard.Wizardhial A (|

Synergy Task View

The integration provides a view designed to work with Synergy tasks.

You must have a Synergy Connection to work with this view. If you open this view without creating a
connection, you will see the following message:

Synergy History | Error Log | Problems | Progress | Console | 65 Synergy Task &3

it
13
n

\Q You haven't added a Synergy Connection yet. Use context menu in Synergy Repository View to add a Connection.

When you add a Synergy Connection to the Synergy Repository, it also appears in the Synergy Task

view.
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= Synergy Task 3

= ﬂ db3-demo
=% tasks i completed last week
=| NOME
=% my assigned tasks
+- =] Lihello - 1.0
- 8 ZiTask 2- 1.0
g test2 - 1
g test-1
=| MOMNE
4| tasks | completed this week

M
13

The Synergy Task view shows tasks assigned to the current user. The name of the task is decorated with

the task number and release. The default task is represented by a light green task icon.

You can expand a task to see the objects associated with it. Each object’'s name is decorated with its

version. The objects’ icons reflect their status.

The Synergy Task view allows you to easily toggle between the Default Task view and Browse Task view.

When Default Task view is active, you see only default tasks for each Synergy connection. When Browse
Task view is active, you can see all the tasks assigned to you for each Synergy connection. You can use

this view to create new tasks and to set a task as the default task.

The various operations available from Synergy Task View are described below:

Add a New Query

1. Switch to the Browse Task View.

2. Click on the toolbar button Add Query {g The query will be added to the Synergy repository that
is selected, or if a task or existing query is selected, it will be added to the repository it belongs to. If

nothing is selected, the default connection will be used.
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(@ - ; —
@Ereate Query
Find... ITasks... [ @t

|mmmm:;r |v B|%user |V -

Task ID ud | Priarity Synopsis

Mame: iy Tasks Query

[ Ok ][ Cancel ]

3. Configure query parameters using the drop-down menus. The equal button can be toggled to
represent “not equal”. Add additional parameters by clicking the plus button. Specify the name and click
OK to add the query to the Task view.

Create a New Task

1. Switch to the Browse Task view.

=
2. Click the toolbar button New Task =
or right-click in the view to bring up the context menu. Click New Task to bring up the Create Task
dialog box.
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& Create Task

Synergy

Create new task

Connection Name: |db3 v|
Task Synopsis: | Example Task |
Resalver: | demo v| EstmatedEffort: | |
Release: 1.0 v|  Estimated Date: [ rowse |
. [ v) Change Request: | || add |
Subsystem: | admin v|

Platform: | X86-WIN32 v

This task fixes: Add
]
Description:
|
':':7:' Create ] [ Cancel

3.

Specify the task name, resolver, release, change request etc., and click Create.

A new task will be created and added to the Synergy Task view.

Set a Default Task

A default task will automatically record the various version control operations you perform using the
integration. You should set a task as your default task as described below:

1.

2
3
4.
5

Switch to the Browse Task view.

Select the desired connection and, if necessary, expand to view all tasks.
Select the task you want to set as the default.

Right-click in the view to bring up the context menu.

Click Set As Default.

The selected task will become the default task, and its icon will change to the default task icon.
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Clear a Default Task

You can clear default task as described below:

A default task will automatically record the various version control operations you perform using the
Integration. You should set a task as default task as described below:

1. Switch to the Browse Task view.

2. Select the desired connection and, if necessary, expand to view all tasks.
3. Select NONE.

4. Right-click in the view to bring up the context menu.

5. Click the menu Set As Default.

The default task will be cleared for the selected connection.

Complete a Task

You can perform this operation either from the Default Task view or from the Browse Task view.
1. Select the desired connection and, if necessary, expand to view all tasks.
2. Select the task you want to complete.
3. Right-click to bring up the context menu.
4

Click Complete Task to bring up the Complete Task dialog box.
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& Complete Task

Synergy
Complete the default task

Connection Mame: | training5_& b |

Default Task: | 20: Task Twenty |

Assodated Objects: Description:

test-1

Release: Actual Effort: | | Change Task

() Complete H Cancel

5. Inthe Complete Task dialog box, provide a description and actual effort, and then click Complete.

The selected task will be completed and the affected projects in your workspace will be refreshed.

View or Modify Task Properties

You can view and modify properties of a task. You can perform this operation either from the Default Task
view or from the Browse Task view.

1. Select the desired connection and, if necessary, expand to view all tasks.
2. Select the task you want to view or modify.

3. Right-click to bring up the context menu.
4

Click Properties to bring up the Properties dialog box.

Page 33 of 87



IBM Rational Synergy for Eclipse Interface 4.2.0

& Properties

Synergy
Default Task Properties

Connection Mame:

Task Mumber: | 2 | Status: | task_assigned |
Task Synopsis: | Task 2 |
Resolver: ||:Iem|:| L | Estimated Effort: |

|
Releasze: | 1.0 v| Estimated Date: Browse
Prioity: v

i

|| Add

Change Reguest:

Subsystem: | Any w |
Flatform: |,.5,|-,3,- v|
This task fixes: Add
I
Description:
':':7:' Update l [ Cancel

5. In the Properties dialog box, make desired changes and then click Update.

View or Modify Object Properties

You can view and modify properties of a task. You can perform this operation either form Default Task view
or from Browse Task view.

1. Select the desired connection and, if necessary, expand to view all tasks.

2. Select the desired task and, if necessary, expand to view all associated objects.
3. Select the object you want to view or modify.

4. Right-click to bring up the context menu.

5. Click Properties to bring up the Properties dialog box.
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& Properties

Synergy
Displays project/object properties

Basic Selection

Comnectons:  cb3 velezse: T |
Mame: test Anoly to Subproiects

Status: working PlakFonm: |-'5-I'IY v|
Owner: demo a )

Type: di

L " Purpose:

Instance: 1

Created: 9/11/08 12:04PM '

Modified: 9/11/08 12:04 PM

Comment Task

2 Add

':':’:' Update ] [ Cancel

6. Make any necessary changes in the Properties dialog box and click Update.

Show History

See How to see History of objects

Refresh View

-
Click the toolbar button Refresh + or on the context menu, click Refresh to refresh the Synergy Task

view.

Note The task view supports drag and drop functions as well as cut, copy and paste as a convenient way to
change task and CR associations. See the Drag and drop and Cut, copy, paste sections for a more detailed

description.
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Compare with Predecessor

Use the Compare with predecessor function to compare the current version of the selected file or folder with
the prior version, if one exists.

This will bring up a dialog similar to the following:

Structure Compare m Java Struckure Compare Q
=] [y workbench_ink = @ CMapi ~
=[S SHT @& do
= [£=s COMm 2 B doConnectionMap
—|- =g telelogic B CMapitboolean)
—| - [ inbegration & associateTaskToObjeck{String, String, String)
=[Sy wswh & checkingString, String, String)
= [24p CSESSIONS @& checkin(String, String)
[z TERA @B checkinTask(String, String, String, String) v
< >

Jawa Source Compare E |<:|=>:| = =3 & 4
CMApijava-7

A

import com.continuus.errorapi.CemwException:

import com.continuus.errorapi.ComlnvalidParawmeterException;

import com.telelogic.integration.vswh, CHM3TesroF lugin:,

import com.telelogic.integration.wswb.hisctoryview.CHSHistorvyElement:

R B R T e R T LI A | CMTTE 5 1 . b
CMApijava-44 CMApijava-7.1.1

import org.eclipse.jface.wizard.Wizardlialog; import org.eclipse.jface.wizard.Wizardlial Cadb
import com.continuus.errorapi.CemwException: import com.continuus.errorapi.CcomExceptior
import com.continuus.errorapi.CemlInvalidParam import com.continuus.errorapi.ComInvalidPe
import com.continuus.ohjectapi.Task: import com.telelogic.integration. wswh. M3
import com.telelogic.integration. vswbh., CHM2Team import com.telelogic.integration.wswh.hist
import com.telelogic.integration.wswh.history import com.telelogic.integration.wswvbh.utci)
import com.telelogic.integration.wswbh.ucil.CH import com.telelogic.integration. vswh.wize
import com.telelogic.integration.wvswh.views.I

import com.telelogic.integration.wvswb.wizards A

o hateele<hrs

/wx *

* bsteele<hr:> ¥ This class serves as @ wrapper for hotl

* *

developer client, but can he switched 1
< > < >

Synergy Toolbar and Menu

The Synergy toolbar and menu offer a quick way to perform task, project open and project checkout
operations.
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2

Q
I A 4
Q| Select Task

% Create Task
#| Complete Task
& Show Task
[ Chedkout Project
ﬁ: Open Project

I show synergy

£ S S
A A A

A

Synergy Menu

These operations are described below:

Select Task

Use this menu or the toolbar button to bring up the Select Task dialog box.

& Select Task

sSynergy
Select the task you want to work an.

Connection Mame: | traininG5_& s |

Default Task: | 20: Task Twenty |

All My Assigned Tasks:

Task... Pri... R... Task Synopsis

14 Any 1.0 test sync 7 UPDATED

15 Ay 1.0 Display synopsis in Mylyn task Synergy editor

19 Any 1.0 new task 123

20 Any 1.0 Task Twenty

none none none  nfa

Create Task

(7 Select l ’ Cancel
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This dialog box will show the default task in the color purple. Select the task you want to set as the default
and click Select.

If the task you want to set as default is not there, click New Task to create a new task.

Create a Task

Use this menu or the toolbar button to bring up the Create Task dialog box.

& Create Task

Synergy
Create new task

Connection Name: |db3 v|
Task Synopsis: | Example Task |
Resalver: | demo v| EstmatedEffort: | |
Release: 1.0 v|  Estimated Date: [ rowse |
. [ v) Change Request: | || add |
Subsystem: | admin v|

Platform: | X86-WIN32 v

This task fixes: Add
]
Description:
1 |
':':7:' Create H Cancel

Specify a task synopsis, resolver, release, etc., and click Create.

Complete a Task

Use this menu or the toolbar button to bring up the Complete Task dialog box.
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& Complete Task

Synergy
Complete the default task

Connection Mame: | training5_& b |

Default Task: | 20: Task Twenty |

Assodated Objects: Description:

test-1

Release: Actual Effort: | | Change Task

() Complete H Cancel

Specify the task description and actual effort time and click Complete.

Show Task Properties

Use this menu or the toolbar button to bring up the Show Task dialog box.
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& Properties

Synergy
Default Task Properties

Connection Mame:

Task Mumber: | 2 | Status: | task_assigned |

Task Synopsis: | Task 2 |

Resolver: ||:Iem|:| L | Estimated Effort: | |

Releasze: | 1.0 W | Estimated Date: Browse

iority: ary

P Any v| Change Reguest: | | [ Add ]

Subsystem: | Any w |

Flatform: | Any Z |

This task fixes: Add

I

Description:

3] Update l [ Cancel

If you want, you can change the task properties. Click Update to save changes.

Check Out a Project

Use this menu or the toolbar button to bring up the Check Out Project dialog box.
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Synergy
Select the project and project version
you want to check out.
Connection Mame: dh3 A |
Scope: |.-5.II demao's Warking Projects L | Mew Version: | demol |
Projects: Project Versions:

test 1

[ ] also Chedk Out Subprojects
Release: |L|SE Current Yalue % | Purpose: Insulated Development w
IUse Default Waork Area
Work Area: | | Browse
Default Task: | 2: aadf |
':':’:' Chedk Out l [ Cancel

The new project version will be recommended by the integration. Choose the release value, task, etc., and
click Check Out. The project will be checked out and added to your workspace.

Open a Project

Use this menu or the toolbar button to bring up the Open Project dialog box.
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& Open Synergy Project

Synergy

Select the project and project version
you want to open.

Connection Name: |traini|'|6 5.6 v|

Working Projects: Project Versions:

lguise ——  /m@i
newprojectdfs
newproject
projects
testprojfds
test

[ ] alzo Open Subprajects

i) Open l [ Cancel

This dialog box will show all the working projects, including prep projects, if you have any. Select the project
and version you want to open. Click Open. The selected project version will be added to your workspace.

Show Synergy

Use this menu or the toolbar button to launch Synergy.
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PQ agincourt - IBM Rational Synergy M=%

Tesk Edt Find View Actions Tools Window Help

¥ (&1 current Task: (=) A#E175: Keep some fies in my project ™ [_Select Currert Task ..
ox | @i-B@aC-E=2e

My MYSCA 0 Colaborative Development Projects
My MYSCH 1 Collaborative Development Projects

iy TBCHIN 2 Collsboraive Develupmem Pru}eds

My 2_patch Projects
My Testdirector /3.5, Jlalch Collaborative Deuempmam Frojects
My Testdirector 3.6 Collaborative Development Projects

My Testdirector/3.7 Callabarative Development Projects

My future Collaborative Development Projects

My ps2.2 Collaborative Developmert Projects

My silverstream Insulsted Developmert Projects

My vsnet2 4 Collaborative Development Projects

My vsnet3.3 Collaborative Developmert Frojects

My vsnet3 4 Collaborative Developmert Projects

My vsnetd 0 Collsborative Developmert Frojects

My vsnetd 1 Collaborstive Developmert Projects

My workhench33 Caliakarative Development Projects

My _patch C D Projects
My _pateh G D Projects
My workbench3s Callaborative Development Projects

My workhench3s_patch Colaborative Development Prajects
My workbench40 Callaborative Development Projects

My workbench4d_patch Colaborative Development Prajects
My workbench41 Callaborative Development Projects

My _patch ive D Projects
My workhenchd?_patch Insulated Development Projects

i My workbenchd? Collaborative Development Projects

94 Basslines Created in Last 30 Days

x
- Srwas
% Groupings (152) | B eclipse_int,bsteele > | [ MSSCCLin... bsteele XV“ B msp_top bsteele XV'-E mysc_svni..bsteclel X || i ChangeGen... bstegle X 4 v E
# 51T W1 77 ColeiGraive D veRpinent Fropes B ecipss_int bstesle ¥ [Members | Properties Hierarchy Work Area
IS ez} Iy 1.7 7a Collaborative Development Projects Name J Type I Wersion J Release I Wodified I State i Owiner]
2 - B My 1.3 Collakorative Development Projects =1l eclipse_int project  bstesle  workbenchd2 MonFe . warking bstesle
2 - B My C7 0 Coliaborative Development Projects Bl di g workbench41... Tue De... irtear.
- By Wy ClearCase/2 0 Colaborative Development Projects - ed,pse int_capabilty project  bstesle workbenchd2 MonFe . working bstesle |
' & My DOORS/S.2_patch Collaborative Development Projects B8 eclipse_int_connection project  bstesle  workbenchd2  Tue Mar... working bsteele |
2 My DOORS/5 3 _patch Collaborative Development Projects - eclipse_int_core project  bstesle workbenchd2 MonFe. . working bstesle |
2 & Wy DOORSI/S.4 Collaborative Development Projects -5 eclipse_int_extension project  bstesle  workbenchd2 Mon Fe... working bsteele |
5 -5 Wy DOORSIS 4_patch Collaborative Development Projects - eclipse_int_feature projct  bstesle  workbenchd2 FriMar ... working bstesle |
2 G-y My DOORS/S.5 Collaborative Development Projects [ [ ey project  bstesle  workbench42 Mon Fe... working bsteele |
5 - B Wy DOORSI5 5_patch Collaborative Development Projects £ eclipse_int_help project  bstesle  workbenchd2 FriMar ... working bstesle |
= (21§54 My DOORS/S.6 Collaborative Development Prajects -5 eclipse_int_mylyn_core project  bstesle  workbenchd2 MonFe... warking bsteels |
Lo - § My DOORSIS.7 Collaborative Development Projects £ eclipse_int_mylyn_ui project  bsteele  workhenchd2 Mon Fe... warking bsteele |
= By My FPSCA 1 Collaborative Development Projects -5 eclipse_int_team project  bstesle  workbenchd Mon Fe... working bsteele |
3 E- S My FESCIL 1R Colaofative Deneiopment Frojects - eclipse_int_ui project  bsteele  workbenchd2 Mon Fe... working bsteele |
4 By My FPSCA 2 Collaborative Development Projects -5 eclipse_int_updatesite project  bstesle  workbenchd2 FriMar . working bsteele |
i - B My FRSCN 3 Callabarative Development Projects - eclipse_int_uti project  bsteele  workbenchd2 MonFe. . warking bsteele |
-5 Wy MSSCCIN 8a Collaborative Development Projects ® dr a1
G- My MSSCCI2 0 Collaborative Development Projects - '
[En
&

User

Synergy Change Request View

The Synergy Change Request view shows all of the change request queries that are associated with the
current user on a Synergy repository connection. It provides the user a convenient way of associating each
task with change requests, which can be created and assigned using the IBM Rational Change interface.
Default shared queries are denoted by faded query icons, and user-defined saved queries are denoted by
opaque query icons. Change requests are denoted by purple rectangular icons and can be expanded to
view the tasks that are associated with the selected change request.

= Synergy Change Request &3 = B8
-y
-
ﬁ db3-dema

R Jdbs-com_root

= . My Assigned Change Reguests
=-E] 5 cr1
B 25:Task1- 1.0
[24| crs resolved by me
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Like in the Synergy Task View, tasks are denoted by yellow rectangular icons, and these in turn can be
expanded to display the objects that are related to the selected task. However, it should be noted that the
Synergy Change Request View displays all tasks related to the change request, regardless of its status or
resolver. Thus, even completed tasks will display in this view.

The various context-menu operations offered by Synergy Change Request View are listed below:

Create a New Task

1. Select a change request from the Change Request view.
2. Right-click the change request to bring up the context-menu.

3. Click Create Task to bring up the Create Task dialog box.

= Create Task |:|E]

Synergy
Create new task

Connection Name: \db3 v|
Task Synopsis: | Example Task |
Resalver: | demo v| CEstmatedEffort: | |
Release: 1.0 v|  Estimated Date: L |[(romse ]
Priority: ich 4 Change Request: | || add |
Subsystem: | admin v|

Platform: | X86-WIN32 v

This task fixes: Add
]
Description:
1 |
':':7:' Create H Cancel

4. Specify the task name, resolver, release, change request etc., and click Create.

A new task will be created and added to the Synergy Change Request view.
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The Change Request view provides an option to allow you to conveniently resolve a change request. This
will open up a browser window that will be directed to the change request’s properties page in IBM Rational

Change.
1.

2. Right-click the change request to bring up the
3.
4

Select a change request from the Change Request view.

context menu.

Click Resolve CR to open up a new browser window.

In the Change Request Information page, click Resolve to resolve the change request.

e

(Usef} : base71 - Windows Internet Explorer

; IBM Rational Change 5

Change Request Information

©cr

Assigned

wﬂesuwe | Admin Tranzition

CRID: 7
Synopsis: test 1

Description: | tooc 1 gescriprion

@ Task

Printer Friendly Wiew | Help

]

More Info..

Status: ir_assigned

HE @

Resolver: |
Release: |
Product Hame: | Product A [v]

Priority: } Any :q

Product Subsystem: ‘ Dialog 1_|3

Associated Task(s): New | Add

TaskID Status Synopsis

No associated tasks.

Associated CR(s):
Associated Requirement(s):
Attachment(s):

Add

Attach Files

Transition Log: Show Transitions [¥] Show Modifications [¥] Show Notes

Expand Log Text | Collapse Log Text

Submitted to ir_created by on 2009/02/25 15:40:17 &

Modifications made by 2009/03/03 11:09:08 &
RTC_URL: —= hitps:/localhest:9443/jazz/resourcs

RTC_ID; —= 38

Transitioned to ir_assigned by
<comments not supplied=

release: —= 1.0
resolver. —=

om.ibm.team. workitem. Workitem/39

on 2009/03/26 15:39:35 &

[ae]

@ Transtion was successful.

5.

View Object Properties

Enter comments in the Comments text field and click Resolve.

The Properties context menu option will display the properties dialog of the connection, task, folder or file
that is selected. If a change request is selected, it will open a browser window with the change request

information as shown in the previous screenshot.

1. Select an item from the Change Request view.

2. Click Properties.
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Complete a Task

1. Select a task from the Change Request view.
2.

3.

Click Complete Task.

IBM Rational Synergy for Eclipse Interface 4.2.0

Right-click the task to bring up the context menu.

& Complete Task

Synergy
Complete the default task
Connection Mame: |trainin65_6 4 |
Default Task: | 20: Task Twenty |
Assodated Objects: Description:

test-1

Release: Actual Effort: | Change Task
':':’:' Complete l [ Cancel

Note: The Change Request view supports drag and drop functions as well as cut, copy and paste as a

convenient way to change task and CR associations. S
for a more detailed description.

Set a Default Task

ee the Drag and drop and Cut, copy, paste sections

A default task will automatically record the various version control operations you perform using the
integration. You should set a task as your default task as described below:

1. Switch to the Browse Task view.

2.
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3. Select the task you want to set as the default.
4. Right-click in the view to bring up the context
5. Click Set As Default.

The selected task will become the default task, and its

Compare with Predecessor

IBM Rational Synergy for Eclipse Interface 4.2.0

menu.

icon will change to the default task icon.

Use the Compare with predecessor function to compare the current version of the selected file or folder with

the last version, if it exists.

This will bring up a dialog similar to the following:

) ey

R R

Gt e d mn rrmrrde a4 1 CMTTE S 1.

Struckure Compare @ Jawa Struckure Compare W
=] (2 workbench_ink - (B CMApI ~
=[Sy sPT B do
= [l oM 2 B doConnectionMap
—|- = telelogic 2B CMApitboolean)
—| - [=g inbegration @B associakeTaskToCbject(String, String, String)
=[Sy wswh & checkingString, String, String)
=[S CMSESSIONS @& checkingString, String)
@& checkinTask(String, String, String, String) “
< >
Java Source Compare E |<:|=>:| = = | 4 4
CMApi java-7
A
import com.continuus.errorapi.CemwException:
import com.continuus.errorapi.CemlnvalidParamecerException;
import com.telelogic.integration. wswh., CHMSTeataP lugin:
import com.telelogic.integration.wswh.historyview.CM3HistoryvElement; 3

CMApijava-44 CMApijava-7.1.1

import org.eclipse.jface.wizard.WizardDbialog: import org.eclipse.jface.wizard.Wizardbial » &
import com.continuus.errorapi.ComException: import com.continuus.errorapil.CcwExceptior
import com.continuus.errorapi.CemInvalidParam import com.continuus.errorapi.CemInvalidP:
import com.continuus.ohijectapi.Task:? import com.telelogic.integration. vswh.CM37
import com.telelogic.integration. vswh., CHM3Tesm import com.telelogic.integration.wswh.hist
import com.telelogic.integration.vswub.history import com.telelogic.integration.wswh.uti]
import com.telelogic.integration.wswh.util.CH import com.telelogic.integration.wsvbh.wiz:
import com.telelogic.integration.wvswh.views. I

import com.telelogic.integration.wswbh.wizards ST

o hateele<hrs

l.."*ﬂ' *

G hsteele<hr> ¥ This olass serves as & wrapper for hotl

* * developer client, but can be switched 1
£ > £ >

Configuring Displayed Change Request Attributes

You can choose which change request attributes are displayed in the Change Request view. This can be
done through the following steps:

1. Open the Synergy Preferences dialog located in Window -> Preferences -> Team in the Eclipse
toolbar.
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2. Inthe CR Attributes section, click Add and enter the name of the attribute to be displayed. You
must enter the name of the attribute, not the label of the attribute. This will add the attribute to the
attributes list.

& Preferences

type filter text - Synergy

+- General

+- Ant

+ Help -General Settings:

+| InstallUpdate ¥ Check Out file(s) automatically when edited

+-Java [V Prompt to add new project files to Syneray

+|- Plug-in Development v Motify for parallel versions on check out

#Run/Debug [¥ Use Three Way Compare

= Team

+-CW5
File Content Label Decorator: (Show selected fields)
Isgnored st ¥ Version ¥ Type v Owner I~ Task
Ynergy
v Release [ Instance [ Status
Data Persistence:
¥ save Synergy Repository view State
v save Synergy Task View State
Project Wizard:
[ Open projects in the order of project nature
CR Attributes:
release Add |
priority
severity Edit ‘
Remove |
Restore Defaults ‘ Apply I
oK | Cancel J
3. Click OK.

4. Close the Change Request view (if open), and re-open it through Window -> Show View in the
Eclipse toolbar.

Note: The inputted attributes must represent valid attributes in the IBM Rational Change server in order
for them to be displayed.

Synergy History View

The Synergy History view shows the history of a project, file, or folder. It can also be used to view parallel
versions. It supports a visual compare and merge feature that shows the differences in two versions of an
object. A typical instance of Synergy History view looks like this:
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Tag Multiline

Comment Parallel Mode Settinas Refresh
urrent Version L
Sortina
= _ _ _ i
[dbd] ... \com_wa\training5_&\newproject1-1\newprojectlisrc\abc123.java &3
=N
L =
W \ersion Owner Status Task Release Created On Instance Type Comment
_ 9/12/08 12:. _ Checked in from Eclipse
2 ccm, root |nhegrate 28 9/12/08 12:. 2 java Checked in from Eclipse
3 ccm_root integrate 28 1.0 9/12/08 12:, 2 java Checked in from Edlipse
4 com_root integrate 28 1.0 a/12/08 12:... 2 java Checked in from Eclipse

Checked in from Eclipse

!

Multiline Comment

Open History View

To open the Synergy History view, you must have a project in your workspace connected to Synergy. To
learn more about how to get a Synergy project into your workspace, refer to following topics:

Synergy Toolbar — Checkout Project

Synergy Repository — Checkout Project

Synergy Toolbar — Open Project

Synergy Repository — Open Project

Migrate Project from within Eclipse

Follow the following steps to open Synergy History view.
1. Select your project in Eclipse’s Navigator view or Package Explorer view.
2. Expand the project and select the resource which you want to view the history.
3. Right-click to bring up the context menu.
4. On the Team menu, click Show In History View.

You can also open Synergy History view from Synergy Task view or Synergy Repository view.

Show/Hide Multi-line Comment
The Synergy History view can be set to switch between show multi-line comment field and hide multi-line

comment filed. Click on the toolbar button D to toggle the multi-line comment field.
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Show Parallel Mode

The Synergy History view can be set to switch between parallel mode and normal mode. When in parallel

mode, parallel versions of the current object version are tagged with the image 1 Also, in parallel mode,
the current object version is always tagged with this image. You can use this mode to identify and merge
parallel versions.

Synergy History Settings
The Synergy History view provides a Settings dialog box to change the way information is displayed in this

view. To bring up this dialog box, click the Settings toolbar button ‘\

Settings §|

Change Synergy History View Settings:

Show Columns:

[v Comment [ Owner [v Task
[v Created On Iv Release [v Type
[v Instance v Status [v Version

Show Versions:
i+ all

" Working Only
(" Parallel Only
{" Between Date

Sort By:

" Instance " Owner " Status " Type

(" Date Created  Release " Task {* Version
Restore Default Apply | Set Cancel

Different options are explained below:
a. Show Columns

Use this option to choose the columns you want to see in the Synergy History view. By default, all
the columns are selected. You can clear the check boxes of the columns you don’t want to see.

b. Show Versions

Use this option to filter out the object versions. If you select All, all versions of the objects are
shown. If you select Working Only, only working versions of the objects are shown. The option
Parallel Only displays only parallel versions. If you choose Between Date, you can choose
versions whose modified time is between dates From and To. The date range is considered
inclusive.

c. Sort By
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Use this option to sort the Synergy History data. By default, Version is used to sort data.

Select Sort Column and Sort Order

In the Synergy History view, you can sort data by entries of a column. To do so, click the column header.
The column will show the down arrow icon |- . The data will be sorted in ascending order.

To sort data in descending order, click on column header again. The icon will be changed to an up arrow
.

Use Version

To use a particular version of an object follow the steps below:
1. Open the Synergy History view.

2. Select the desired version in Synergy History view.

w

Right-click to bring up the context menu.
4. Click Use Version.

5. The selected version will become the current version.

Compare Version

To use a particular version of an object, follow the steps below:
1. Open the Synergy History view.
2. Select two versions you want to compare.
3. Right-click to bring up the context menu.

4. Click Compare Version. The result will be shown in Eclipse’s compare editor.
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[ de = null;

& | |

>

[ oz = new CCHMWCMChiect(): [

)}{‘ oo = new CCMVCHMObject () : |

& 1l |

BE Java Struckture Compare Q
o CeldiI ~
& de =
@41 dcConnectioniap
4 CMApi{boolean)
@41 assoriateTaskToOhjeck(String, String, String)
@43 checkin{String, String, String)
- @4 checkin{String, String) v
Ef Java Source Compare @ % | E{> @ | 4 i
BE CMapijava-19
public CMipi (bhoolean useleveloperClient) | .
super (] ; =
delim = nall:
if [useDewvelopercClient)
{ b/
EF CMApijava-20 4 | EF CMApijava-44
public CMipi (boolean useleveloperClient) LF) L
super (] ; public CHMipi(boolean useleveloperClier =
delim = nuall; super () ;
| o delim = nuoll;
if [useDevelopercClient) if juseblewveloperclient){
{ | useDC = true; |
| usebDC = true; deConnectionMap= new HashMap ()
| dc = new CCHDCOhject(): Sl Jide = new CCMDCOhiect(): E
| oz = null; | oo = null; |
¥ /D/I Jelse{ |
else | uzelC = false; |
i Fide = null:
| uselC = false: | deConnectionMap = null;

If folders are compared, you will get the following dialog boxes.

@ Directory Compare of doc,11 and doc, 10 - agincourt - IBM Rational Synergy

=Jo/es

B =3 ™

: Unigue Enttries | Common Er'rtriesl

doc,11 doc,10
Mame 2| Type I Instance Mame 2| Type Instance
issues.htm html A#

|
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This operation is used to merge a parallel with the current version of an object. The merge editor opens in
Eclipse. You can see the differences between the two versions and locate the conflicts. The common

ancestor is also shown to help resolve conflicts.
To merge two parallel versions, follow the steps below:

1. Open the Synergy History view.

2. Identify the two versions you want to merge. Make one of them the current version. The two

versions must be in a static state.

3. Select two versions and right-click to bring up the context menu.

4. Click Manual Merge to open the merge editor.

) ey

R R

Gt e d mn rrmrrde a4 1 CMTTE S 1.

Struckure Compare @ Jawa Struckure Compare W
=] (2 workbench_ink - (B CMApI ~
=[Sy sPT B do
= [l oM 2 B doConnectionMap
—|- = telelogic 2B CMApitboolean)
—| - [=g inbegration @B associakeTaskToCbject(String, String, String)
=[Sy wswh & checkingString, String, String)
=[S CMSESSIONS @& checkingString, String)
@g CMApi.jav, @& checkinTask(String, String, String, String) “
< >
Java Source Compare E |<:|=>:| = = | 4 4
CMApijava-7
A
import com.continuus.errorapi.CemwException:
import com.continuus.errorapi.CemlnvalidParamecerException;
import com.telelogic.integration. wswh., CHMSTeataP lugin:

import com.telelogic.integration.wswh.historyview.CM3HistoryvElement; 3

CMApijava-44 CMApijava-7.1.1

import org.eclipse.jface.wizard.WizardDbialog: import org.eclipse.jface.wizard.Wizardbial » &
import com.continuus.errorapi.ComException: import com.continuus.errorapil.CcwExceptior
import com.continuus.errorapi.CemInvalidParam import com.continuus.errorapi.CemInvalidP:
import com.continuus.ohijectapi.Task:? import com.telelogic.integration. vswh.CM37
import com.telelogic.integration. vswh., CHM3Tesm import com.telelogic.integration.wswh.hist
import com.telelogic.integration.vswub.history import com.telelogic.integration.wswh.uti]
import com.telelogic.integration.wswh.util.CH import com.telelogic.integration.wsvbh.wiz:
import com.telelogic.integration.wvswh.views. I

import com.telelogic.integration.wswbh.wizards ST

o hateele<hrs

l.."*ﬂ' *

o hateele<hr> * This class serves as a wrapper for hoth

& * developer client, but can be switched 1
£ > £ >

5. Use this editor to merge and resolve conflicts.

6. When all the conflicts are resolved, on the Eclipse File menu, click Save. A new version of the
object will be created as the result of this operation. Close the merge editor.

Automatic Merge

The automatic merge operation will use Synergy’s built-in merge and conflict resolution tool. A new version
of the object will be created automatically. This operation will not change your current version.
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To merge two parallel versions automatically, follow the steps below:
1. Open the Synergy History view.

2. ldentify the two versions you want to merge. Make one of them the current version. The two
versions must be in a static state.

3. Select two versions and right-click to bring up the context menu.

4. Click Automatic Merge.

5. An automatic merge is performed and a new working version of the object will be created. The
resulting version may contain conflict markers if automatic merge was unable to resolve certain

conflicts. Open the newly created version and check for any conflict markers.

The automatic merge operation will bring up the following merge tool.

== Telelogic Synergy Merge

File Edit Options Help

ﬁ @[I:T:l] [ﬁ][@m@] @ |"0 Changed 1@7 - Middle; Changed 167 - Right v.

—RequestParameters java 491 1= ey file= ReguestParameters java 79= £
1z /5% L1z /7% | =
2 ¥ o 2 F
3: * RBequestParameters Class 3: * RequestParameters Class 3: * BequestParameters Class
4 o] e ¢ Hi
5 %/ e b
A1 6t 61
Tipackage coh.cohtitmus.webpt. serwvl || Tipackage com.telelogic.cs: Tipackage com.m
g: a: g:
Brimport Jawa.io.®; S:import jawa.io.®; S:import jawva.io.®;
10:import java.util.*; 10: import java.util.*; 10:import java.util.*;
1l:import javax.serwlet.httph.*; 1l;import javax.serwlet.http.®; 1l:import javax.servlet.http.®;
1Z2:import gnu. regexp.®; l1Z2:import com. telelogic.cm.jrfc.type 1zZ:import com.tglelogic.cm.jrfc.ty'pﬁ.

13:import COm. CONtinuus. wehaynmergy. 13:import com.telelogic.cs.cmapi.*: 13:import
l4:import com.continuuz.websyneroy. l4:import com.telelogic.cs.process. .M || 14:importc
15:import com.continuus. wehsynerdy. 15:import com. telelogic.cs. zervlet. 5 lS:imporf:
lé:import com.contimas. jrfc. types. g t

17:import com.telelogic.cs.user.*; 16:inport .telelogic.cs.user.*; 3 con. telelogic.ca.user. *;

15: 20: -

19:public class RequestParameters 2l:public clags RecuestParameters Zl:public class RequestParameters

20 221 2211

ol final static public int C3aP || 23: final static public int ESABE (|25 final static public int CZAPT M

22z final static public int NOT_ || 24: final static public int NOT C || 24: final static public int NOT C34
< | >
Linchanged text Block statistics: Inserted: 058 | Modifiect 0553 ] Deleted: 0M | Edited: 0 | Conflicts: O | Total: 72

Merge and Keep Current Version

To merge two parallel versions, follow the steps below:
1. Open the Synergy History view.

2. Identify the two versions you want to merge. Make one of them as current version. The two
versions must be in a static state.

3. Select two versions and right-click to bring up the context menu.
4. Click Merge and Keep Current Version.

5. A new working version of the object will be created. The content of the resulting version is the same
as that of the current version (the other version used in merge will be ignored).
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Merge and Replace Current Version

To merge two parallel versions, follow the steps below:
1. Open the Synergy History view.

2. ldentify the two versions you want to merge. Make one of them as current version. The two
versions must be in a static state.

3. Select two versions and right-click to bring up the context menu.
4. Click Merge and Replace Current Version.

5. A new working version of the object will be created. The content of the resulting version is replaced
by the other version of the object used in merge (current version will be ignored).

Refresh

-
Click the toolbar button Refresh # | or on the context menu, click Refresh View to refresh the Synergy
History view.

Mylyn Views

The integration extends the Eclipse Mylyn views in order to allow you to use Mylyn capabilities in
conjunction with Synergy repositories and tasks. More information about Mylyn and its features can be
viewed on the Eclipse website.

Mylyn Task Repositories View

Once a Synergy repository has been added to the Synergy Repository view, it can be added to the Mylyn
Task Repositories view. Adding the repository to Mylyn will enable you to use Mylyn functionality with tasks
from that particular repository.

The image below shows the Task Repositories view with 2 Synergy repositories denoted by the Synergy
icon.

@TaskRepusib:ries &3 o~ = d

[1:, Local Tasks
D{ Edipse.org
[ trainings_4
¥ trainings_s
D_.;.Edgewall
D_.;.MyTrac

Adding a Synergy Repository to Mylyn

1. Ensure that repository has been added to the Synergy Repository view.
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2. Click on the Add Task Repository icon on the top right corner of the Mylyn Task Repositories
view or select the same option from the context menu.

3. Select Synergy Repository in the Select Repository Type dialog.

4. Select a repository from the Server drop-down menu and click Finish.

Mylyn Task List View

After a Synergy repository has been added to Mylyn, you can add queries to the Mylyn Task List to import
Synergy tasks from that repository and use Mylyn functionality such as attaching contexts and scheduling.

Adding a Synergy Query to Mylyn Task List

1. From the Task List context menu, select New -> Query to bring up the New Repository Query
dialog box. Select the Synergy repository to query to bring up the New Synergy Query dialog and
click Select Query.

2. Select an existing query from the query list or create a new query. Click Select to choose the query
to be added to the Task List. The Select Query dialog box is shown below:

£ Select Query E]

Synergy Aelelogic

Select a query.

Saved Jueries;

Mame Query String o
tasks i completed last week completed_id="%user' and completion_date »=time{ %last_week_bedgi...
status="task_assigned' and owner="%wser'
tasks i completed this week completed_id="%:user' and completion_date ==time( %this_week_bedgi...
my tasks query (4) task({3"
my tasks query (1) status="task_assigned' and owner="%Guser’
my tasks query owner="%user'
my tasks query (&) est_duration="g'
my tasks query (5) actual_duration="3' -
my tasks query (7) task_subsys="admin’
my tasks query (2} est_completion_date »=time{Monday, March 31, 2008 00:00:00% and ... Z
s dmmlem s 0T s T [P PETor e L =

i) Select ] [ Cancel

The image below shows the Mylyn Task List with an added Synergy query and its corresponding tasks.

Note: If a Synergy task in Mylyn is set as “Active”, it will automatically become the default task in Synergy.
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Find: | | P Activate...
% Uncategorized
= & [&- my assigned tasks - training5_5 [ <unknown host: ]

|=_? 11: Task eleven

S 10: Task ten

[0 1 Task one

Ei’ 3: Task three

['% 4: Task four

['% &: Task six

2T .

T3

[

B¢ eeee

Il >

Synergy Mylyn Task Editor

Planning Tab
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7] 9: Task Nine £3 -
0 Task 9 trainin6s_ 6 % & | ©

+ Personal Planning

Scheduled for: |ChDUSE Date :| # Due: |JUI'I 26, 2008 8:19 AM \_fl b4 Estimated hours: | 1 =l 4
Active: | 7 minutes | b4
Notes

& Flanning | @ Context | ® Synergy

The planning section can be used to schedule the task in both Mylyn and Synergy. The date and time values
will determine how the task is categorized in the Task List view if it is set to display according to schedule.
The Due field is also linked to the Synergy task Estimated Date field.

Synergy Tab
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7| 20: Task Twenty &2
0x Task 20 trainin65_6 % @ |E|

20 : Task Twenty

+ Task Properties

View [ Update

« Attachments (3)

Mame Description Size | Creator Created
“@ Task Context mylyn/context/zip 487 bytes  usjowo <usjowo> Jul 23, 2008 2i...
296,68 KB  usjowo <usjowo:  Jul 23, 2008 3:...

screenshot.png screensho
overlayqueryicon.gif  asd 866 bytes  usjowo <usjowox  Jul 23, 2008 4.,

[ |=| Attach... ] [ {2 Attach Screenshot. ..

fE Planning | @ Context m Synergy

The Synergy tab displays basic information about the Synergy task such as its ID, description, and last
synchronized time. It also displays a list of each file and the context that is attached to the repository task.

Furthermore, it allows for you to quickly modify the task properties through the View/Update button.

Context Tab
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| 20: Task Twenty &3 =B
0s Task 20 trainings 6 % § || @
- Actions + Elements
= 22 test
—+1
S J = src

a{'}j P 1 (default package)
ch context...

<] Retrieve Context...

“@ Copy Contextto...
& Clear Context

& Planning | @ Context | m Synergy

The Context tab displays the context that is currently associated with the task. This context can be attached
to the Synergy task by using the Attach Context link under the Actions section. It can then be retrieved by
any other user with using the integration with access to the task with the Retrieve Context link.

Note: If a context is attached to a task that has an existing context attachment, the uploaded context will
overwrite the existing context. Currently Synergy tasks can have only 1 context attachment.

Page 60 of 87



IBM Rational Synergy for Eclipse Interface 4.2.0

Synergy Team Preferences

This integration provides a Team Preference which you can use to change the way the integration works.
To bring up the Team Preference follow the steps below:

1. Bring up the Eclipse Preferences dialog box.

2. Expand the Team category and select Synergy.

& Preferences |;_ |

type filter text - Synergy

+- General
+- Ant
+ Help -General Settings:
+| InstallUpdate ¥ Check Out file(s) automatically when edited
+-Java [V Prompt to add new project files to Syneray
+|- Plug-in Development v Motify for parallel versions on check out
#Run/Debug [¥ Use Three Way Compare
= Team
+- CVS
File Content Label Decorator: (Show selected fields)
ISQYIT_I:_Zi st ¥ Version ¥ Type v Owner I~ Task
v Release [ Instance [ Status

Data Persistence:
¥ save Synergy Repository view State
v save Synergy Task View State

Project Wizard:
[™ Open projects in the order of project nature

CR Attributes:
release Add |
priority
severity Edit ‘
Remove |
Restore Defaults ‘ Apply I
oK | Cancel J

The various options in Synergy Team Preference are explained below:
a. General Settings

Check Out File(s) automatically when edited: If you try to modify a file without checking it out
first, the integration will automatically check it out for you, if this option is selected.

Prompt to add new project files to Synergy: Select this option if you want the integration to add
newly created java files to Synergy. The integration will prompt you first.

Notify for parallel version on check out: If you select this option, the integration will notify you
when a check out operation results in parallel versions.
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Use three way compare: If you select this option, the ancestor window will be shown during
compare operation.

b. Label Decorator

You can select the fields you want to make part of label decorators. The fields will be separated by
character ‘:’.

+-¥= images - 1 : dir : D1#75 : D1#8
ﬂ _cerwaid,inf
about,html - 2 2 bl : D1#110: D16
8 about.ini - 2 1 ascii : D1#110: D1#6
=| about.properties - 1 1 ascii : D1#7S: D1#6
@ build properties - 1 1 asci : D178 : D1#17
] build,xml - 13 =l D1#78 : D16
plugin.properties - 1 : asci : D1#73 ; D1#6
¥ plugin.eml - 1 =l D1#78 : D1#17
ukiljar - 1 1 jar s DL#73 : D1#L
¥ utilplugin.ini - 1+ ascii : D1#73 : D1#1
welcome, xml - 15 xml: DL#73 : D16

c. Data Persistence

You can choose whether or not to save your Repository view state and Task view state between
sessions. If you choose to save, the corresponding view will be created using saved data instead of
data from Synergy database. To see the current database state, refresh the views.

d. Project Wizard

This section allows you to specify the order in which your projects will be opened during checkout
project and open project operations. The order depends on the project nature of projects being
opened. This is especially useful for opening projects with multiple subprojects that have
dependencies between them.

Note: projects that do not have a project nature or have a nature that is not specified in the project
wizard will be opened before those that fit the project wizard criteria.

e. CR Attributes

This section allows you to specify which CR attributes are to be displayed in the Change Request
view next to each CR. See the Change Request section for additional description.

Label Decorators

When a project in Eclipse is connected to Synergy, the icon and name of resources are decorated to give a
visual indication that the project is in under Synergy.

Controlled Project Uncontrolled Project

& =

Checked In File Checked Out File Uncontrolled File Checked Out by
another user

s 15 B
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Checked In Folder Checked Out Uncontrolled Checked Out by
Folder Folder another user
W W
= = = ta

Synergy Console View

The integration uses Eclipse’s basic console view to output results of various operations

Synergy History | Error Log | Problems =" Eﬁ = [f-=48

ynergy
The file c:/cmsynergy/usjowo/ccm wa/agincourt/eclipse int connection-usjowo/eclipse int_connection/notifier/CMDevClientCompl
The file

c:/cmsynergy/usjowo/com wa/agincourt/eclipse int connection-usjowo/eclipse int connection/notifier/CMDevClientTaskListener £
15 missing from Plugin's installation path. The integration will not function with Synergy for Develolopers. Exit the IDE a

You should use this view to check for any error or warning messages. The messages are color coded.

Synergy Offline Mode

While in offline mode, all connections to Synergy repositories will be stopped and all Synergy functions will
be disabled. This allows you to continue to work on projects even if the integration is unable to connect to a
repository.

Once you are in offline mode, the following message will appear in the Task View, Change Request View,
and Repository View:

Synergy Change Request X =1

s ||
13

You are currently working offiine. Click the Work Offline toggle button on the Synergy toolbar to return online.

You may return to working online by unchecking the Work Offline Mode box in the Synergy Preferences
dialog box. Upon coming back online, the integration will attempt to connect to each repository connection.
If the integration detects that a project has been modified while working offline, a dialog will appear with a
list of all projects that may now be out of sync with the Synergy repository.
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& Synchronize Work Area

Synergy

The contents of the following projects were modified while working in offline mode.
It is recommended that they are synchronized before working online.

Select a project below and didk on the Synchronize button,

C: /documents and settings/usjowo/my documents/synergy focm_waftraining5_6/test?-1/test?

(7 Synchronize l [ Cancel

You may use this dialog box to individually select projects to synchronize with the Synergy repository.
Notes:

- Refactor operations involving renaming or moving an object are blocked while in offline mode.
This is done to prevent irreconcilable conflicts with the Synergy database.

- You may have to manually refresh the status of the projects in the Eclipse Navigator or Package
Explorer views after performing a sync operation in this fashion. To do so, use the Team context-
menu’s Refresh Status option, which is described in the following section.

Daily Development

Daily development refers to the activities performed by the team members during everyday development.
Once a development or a build management project is set up, daily development primarily involves the
activities of modifying files. Synergy is a task-based configuration management. In order to keep track of
daily development activities effectively, one should associate them with a Synergy task. This section also
describes many other operations that can be performed using the Integration.

Most of these operations are available from the Team menu. Below is a picture of the Synergy Team
menu:
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Apply Patch...

Bj Project History Displays history of project

Praject Conflict Shows membership conflict of project
G. Project Properties Displays project properties
#8 Update Members

Add Uncontrolled Files Adds uncontrolled files/folders to Synergy

Removes controlled files/folders from Synergy
a Sync Synchronizes work area and database

B Check Out Checks out selected files/folders
5 CheckIn Checks in selected files/folders
B Undo Check Out  Undoes check out of selected folders

@ Check Out Tree Checks out selected folder and its children
&3 Check In Tree Checks in selected folder and its children
" Undo Check Out Tree  Undoes check out of selected folder and its children

B Show inHistory View  Shows history of selected file/folder in Synergy History View

I= History Shows history|of selected file/folder using Synergy for Developer
& Properties Displays properties of selected file/folder

Refresh Status  Refreshes the version control status of selected project/file/folder

){ Disconnect Disconnects from Synergy

How to Use Task-Based CM

Whenever you check out a file, the check-out operation is tracked with your default task. You should select a
default task before you modify files after checking them out. When you are done, you should check in your
default task instead of checking in the individual files. To check in a task or to create a task, use the Synergy
toolbar.

You can set a default task for each Synergy Connection. To do this, you can use the Synergy Task view
or Synergy Toolbar.

You can use the Synergy Task view to find out what default task is set for a Synergy Connection.

The integration will prompt you to select a default task if you perform an operation which requires a default
task.

You can either select an existing task as default task or create one.

How to check out

You must check out files before you start modifying them. To check out files, on the Team menu, click
Check Out. You can select multiple files/folders to check out.
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& Check Qut

Synergy
Select Files to Check Qut.

Task: | 20: Task Twenty | Select

Files:

c:/documents and settingsfusjowo/my documentsfsynergy focm_wa/ftraining5_6/test2-1/test2fsrcfhelloworld. java
c:/documents and settingsfusjowo/my documents/synergyfoocm_waftraining5_6/test2-1/test2fsrcfhelloworld2. java
c:/documents and settings fusjowa fmy documents/fsynergyfocm_waftraining5_6/test2-1/test2fsrcfhelloworld3.java

Comments:

(7 [ Check Out H Cancel

In the Check Out dialog box shown above, all selected files will be checked out. Also from this dialog box,
you can change your default task and specify a check-out comment.

Before the above dialog box appears, you will be notified if the check out would result in any parallel
versions.

If you want to check out all files and folders belonging to a folder, on the Team menu, click Check Out
Tree.

Note An object may be automatically checked out by the integration if the user modifies its contents
without explicitly checking out the file. This will not occur, however, if the user modifies the object using an
external editor.

How to check in

To check in, on the Team menu, click Check In. You can select multiple files/folders to check in.
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£ Check in |:IE]

Synergy
Select Files to Chedk In.

Files:

c:/documents and settings/usjowo/my documentssynergyfcocm_wa/firaining5_6test2-1ftest?fsrc/helloworld java
c:/documents and settings fusjowao/my documentsfsynergyjccm_wa/ftraining5_6test?-1/test2fsrcfhelloworld 2. java
c:/documents and settings /usjowao/my documents/synergyjccm_wa/ftraining5_s/test2-1/test2fsrcfhelloworld3.java

Comments: | |

2] [ Check In H Cancel

In the Check In dialog box shown above, all selected files will be checked in.

If you want to check in all files and folders belonging to a folder, on the Team menu, click Check In Tree.

Note You should complete your default task, rather than check in individual files.

How to undo check out

To undo a check out, on the Team menu, click Undo Check Out. You can select multiple files/folders for
this operation.
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& Undo Check Out

Synergy
Select Files to Undo Chedk Qut.

Files:

c:/documents and settingsfusjowo/my documents /synergyfcocm_wa/training5_6 /test2-1/test2 ferc/helloworld. java
c:/documents and settingsfusjowo/my documentsfsynergyfcocm_wa/training5_g/ftest2- 1ftest2 fzrofhellowarld 2. java
c:/documents and settingsfusjowo/my documentsfsynergyfcocm_wa/training5_g/ftest2- 1ftest2 fzrofhellowarld 3. java

(7 Undo ] [ Cancel

If you want to undo a check out of all files and folders belonging to a folder, on the Team menu, click Undo
Check Out Tree.

How to view/modify a project, file, and folder properties

Project Properties

To view/modify project properties, on the Team menu, select Project Properties. You will see the
Properties dialog box.
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& Properties

Synergy
Displays project/object properties

Basic Selection
Connection: b3 Reease: | I ~
Mame: projfordb3 []apply to Subprojects
Status: working Platform: |,.g.||-,\)‘f b |
Owner: demo [J Apply to Subprojects
Type: project .

Purpose: |Insulateu:| Development i |
Instance: 1

[] Apply to Subprojects

Created: 9/12/08 2:10 PM

Modified: 9/12/08 2: 12 PM

Comment Task
6 Add

Remaove

Show

(7 Update H Cancel

You can add more tasks, view associated task properties and remove tasks.

File/Folder Properties

To view/modify project properties, on the Team menu, select Properties. You will see the Properties dialog
box.
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& Properties

Synergy
Displays project/object properties

Basic Selection

Connection: ~ db3 Release: | N ~
Mame: test

Status: working Platfarm: | Any V|
Owner: demo

Type: di

¥pe " Purpose:

Instance: 1

Created: 9/11/08 12:04 PM

Modified: 9/11/08 12:04FM

Comment Task
2 Add
':':’:' Update H Cancel

You can add more tasks, view associated task properties, or remove tasks.

How to add files to Synergy

If you add new files or folders to your workspace, you should add them to Synergy as soon as possible. To
perform this operation, on the Team menu, click Add Uncontrolled Files. You must have a default task to
perform this operation. This operation leaves the files in the checked out state.

How to remove files from Synergy

If you no longer want to control a file in Synergy, on the Team menu, click Remove Controlled Files. This
operation removes files from Synergy, as well as your workspace. If you want to keep these files on your
local drive, you should save a copy before performing this operation.

How to get latest version

On the Team menu, click Update Members to get the latest version of project files.

If you perform this operation on a project, the project will be reconfigured. You can select multiple projects
for this operation.
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How see project conflicts

Select a project for which you want to see membership conflicts.

On the Team menu, click Project Conflict. The project conflict dialog will appear.

] Membership Conflicts for ChangeGenericSynchronizer, - agincourt - IBM Rational Synergy g@

MR =2 a B

Actioned File 21 | object Tasks Category

|:| =| A#12566: Checkout clas... Missing changes
|:| ChangeGenericSynchronizer bsteslel. \col.. classpath,3.1.11 =| A#12277: Create new pr... Parallel changes
|:| ChangeGenericSynchronizer bsteelet. . Aol classpath,3.1.12 =| A#12517: Modify Change... Parallel changes
|:| ChangeGenericSynchronizer bsteelel. . \cl... classpath, 31101 1 =| A#12565: Sync Ul chang... Parallel changes
|:| ChangeGenericSynchronizer bsteelel. . \cl... classpath,3.1.13 =| A#12565 Sync Ul chang... Parallel changes
|:| ChangeGenericSynchronizer bsteele\. . \Ge... =| A#12277: Create new pr... Parallel changes
|:| ChangeGenericSynchronizer bsteelel. . \Ge... =| A#12565 Sync Ul chang... Parallel changes
|:| ChangeGenericSynchronizer bsteele).. \ch... =| A#12565: Sync Ul chang... Missing changes
|:| ChangeGenericSynchronizer bsteele). . lint... =| A#12277: Create new pr... Parallel changes

9 conflicts found

How to see History of objects

You can see the Synergy history of a file or folder by using the Show History option in the Task, Change
Request, or Repository view context menus. For more information about this dialog, refer to the Synergy
help file.
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0 History for GenericChangeSyncinterfacelmpl.java - agincourt - IBM Rational Synergy g@
HlWEge oA 7 |BF 2
14 B1s

Type: java MName Version £ | Type State Qwner Task Release |

[ Genericc... 1 java integrate -~

[ Gener
[ Gener
[ Ge

java integrate
java integrate
java
java
java ir
java released

B Gener java integrate A
java integrate 3
java integrate
java integrate
java integrate

java
java
java released
java integrate change-cgf1 .0

S Coruari 4

N |
]

1
1
|
A
|
A
1
A

GR

[v

This dialog can be activated in the following ways:

From Synergy Repository View

1. Select the desired connection and, if necessary, expand to view available projects.
2. Select the desired project and, if necessary, expand to view project files and folders.
3. Select a file or folder and right-click to bring up the context menu.

4. Select Show History. The Synergy History dialog box for the selected file or folder will appear.

From Synergy Task View

1. Select the desired connection and, if necessary, expand to view available tasks.

2. Select the desired task and, if necessary, expand to view associated files and folders.
3. Select a file or folder and right-click to bring up the context menu.
4

Select Show History. The Synergy History dialog for the selected file or folder will appear.

From Synergy Change Request View

1. Select the desired connection and, if necessary, expand to view available tasks.
2. Select the desired task and, if necessary, expand to view associated files and folders.

3. Select afile or folder and right-click to bring up the context menu.
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Alternatively, the history of a file can be shown in the History View:

From Workspace View

1. Select your project in Eclipse’s Navigator view or Package Explorer view.

2. Expand the project and select the resource which you want to view the history.
3. Right-click to bring up the context menu.
4

On the Team menu, click Show in History View.

Tag Multiline
Comment Parallel Mode Settinas Refresh
urrent Version .
Sortina
N _ _ _ Vv v
[dbd] V... \com_wa\fraining5_& \newproject1-1\newprojectierc\abc123.java &3
Om®a 2
P
W \ersion Owner Status Task Release Created On Instance Type Comment
_E- 9/12/08 12:. _ Checked in from Ecipse
2 ccm_root integrate 28 9/12/08 12:. 2 java Checked in from Eclipse
3 ccm_root integrate 28 1.0 9/12/08 12:. 2 java Checked in from Eclipse
4 ccm_root integrate 28 1.0 a/12f08 12:... 2 java Checked in from Eclipse

Checked in from Eclipse

!

Multiline Comment

Note: If the selected file or folder does not belong to a working project opened in Eclipse workspace, the
Synergy History view will not be activated.

How to use drag and drop

The drag and drop functionality offers a convenient way to transfer or copy objects within the Task or
Change Request views, or between each other. This allows you to quickly change a file or folder’s task
association, or change a task’s CR association. Only files, folders and tasks may be transferred in this
manner.

Changing task associations for files and folders

Files and folders may be dragged from one task to another. This can take place between 2 tasks within the
Task view, 2 tasks within the CR view, or between a task in the Task view and a task in the CR view.
Dragging the object from the task and dropping it to another task will associate it with the task that it was
dropped on, and disassociate it from its original task. You may perform a “copy” operation by holding the
CTRL key while performing the drag-and-drop operation, and the file or folder will become associated with
its new task without being disassociated with its old task.

Note: A file or folder under a task may not be copied using the drag-and-drop operation into a task that
belongs to a different connection.
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Changing CR associations for tasks

Tasks may be dragged from one CR to another within the Change Request view. Dragging the task from
the CR and dropping it to another CR will associate it with the CR that it was dropped on, and disassociate it
from its original CR. You may perform a “copy” operation by holding the CTRL key while performing the
drag-and-drop operation, and the task will become associated with its new CR without being disassociated
with its old task.

Note: A task under a CR may not be copied using the drag-and-drop operation into a CR that belongs to a
different connection.

How to use cut/copy/paste

Like the drag and drop functionality, the cut, copy and paste functions offer a convenient way to transfer or
copy objects within the Task or Change Request views, or between each other. This allows you to quickly
change a file or folder’s task association, or change a task’s CR association. Only files, folders and tasks
may be transferred in this manner.

Changing task associations for files and folders

Files and folders may be cut or copied from one task and pasted to another. This can take place between 2
tasks within the Task view, 2 tasks within the CR view, or between a task in the Task view and a task in the
CR view. The cut function will disassociate the selected files or folders from their tasks and place them on
the clipboard, while the copy function will only place them on the clipboard. You may then use the paste
function to associate them with a selected task.

Note: A file or folder under a task may not be pasted into a task that belongs to a different connection.

Changing CR associations for tasks

Tasks may be cut or copied from one CR and pasted to another within the Change Request view. The cut
function will disassociate the selected tasks from their CRs and place them on the clipboard, while the copy
function will only place them on the clipboard. The user may then use the paste function to associate them

with a selected CR.

Note: A task under a CR may not be pasted into a CR that belongs to a different connection.

How to synchronize a work area

Use this procedure to compare the files in your work area to those in the database and resolve the
differences.

This operation is useful if you've manually changed files in the file system without checking out the files or if
a project update fails because of changes in the file system. By syncing the work area, you can select a
conflict in the Work Area Conflicts dialog box, then compare the differences from the file in the file system
with the file in the database.
The following operation discusses ways in which to resolve work area conflicts after a sync.
1. Right-click over a modifiable project in the Navigator or Package Explorer view, select Sync
under the Team submenu.

The Work Area Conflicts dialog box appears.
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2. Review the list of conflicts.

3. Resolve conflicts.

You can resolve conflicts in the following ways: discard work area changes, keep work area
changes, or ignore files you do not want to control.

\J Work Area Conflicts for sync_framework_install,foo - agincourt - IBM Rational Synergy

b BER

File 21 | confict
Cilcem_walegincout SyncServertl #oolsyne_rameweri oo wiork Area Changes  95108NTK chronizer logicirtegration\adminichangechangeadapter\123DSECS0D0. . File added to the work arez
Co\cem_walagincourt SyncServert 4tfaoisync_framework i ge\Generi \chronizertwebapps Tiogicltegration'adminichangschangeadapterl023D3ECSD0... File added to the work area
oriiem witsanEatE neservertl Aackync Famewerk 4. DecardWork Aes CIunges 1 e hre Ol giclrteg o geadapter023DSECS0D0. . File added to the work area
Cileem_walagincourt SyncServertl 4tfooisyne_framewaork_installisync_framework_nstallCD neri chronizertwehapps Tiogictegrationiadminichangechangeadaptertl 2ADIABCEAE...File added to the work area
Cricem_walagincourt SyncServertl 4tfooisync_framework_instalisync_framework_nstallCD . ynchronizerwebapps Tiogicitegrationtadminichangechangeadapter\ 2AD3ABCE4S.. File added to the work area
Colcem_walagincourt SyncServer | 4faoisyne_framewark_instalisyne_frameworl_nstalliCDimage\GenericChangeSynchranizertwebapps Tlogickiegration'adminichangechangeadaptertl 2AD3ABCE48... File added to the work area
Cricem_walagincourt SyncServertl 4tfooisync_framework_installsync_framework_installCD neri ynchronizerwebappsiTiogicitegrationtadminichangechangeadapter\i CAD27146D3... File added to the work area
Coicem_walagincourt SyncServer 4fasisyne_framewark_instalisyne_framework_stalliCDimage GenericC} gichteq igechangeadaptert CAD27148D3. . File added to the work area
Cilcem_walagincourt SyneServertl 4tfooisyne_framework _installsync_framewark_nstallCD neri chronizertwehapps Tiogictegr ationladminichangechangeadapterl CAQ2T1 46D3... File added to the work area
Cr\cem_walagincourt SyncServertl 4tfaoisync_framework_installisync_framework_installCD : \chronizeriwebapps Tiogicintegration'adminichangschangeadapter| E2687 A4AAG .. Fils added to the work area
Colcem_walagincourt SyneServer | 4faotsyne_framewark_installsyne_frameworl_nstalliCDimage\GenericChangeSynchranizertwebapps Tlogickiegration adminichangschangeadapter 30DFFESE3S4. . File added to the work area
Co\cem_walagincourt SyncServertl 4tfaoisync_framework_instalisync_framework_installCD neri \chronizertwebapps Tiogictegration'adminichangschangsadapter GDFFEBB354... File added to the work area
Coicem_walagincourt SyncServertl 2fasisyne_framework_installsyne_framework_nstalliCDimageiGenericC} gichteq igechangeadapter 30DFFEBB354. . File added to the work area
Cileem_walagincourt SyncServertl 4tfooisyne_framewaork_installisync_framework_nstallCD neri chronizertwehapps Tiogictegrationtadminichangechange adapter\3E50S0BES 77...File added to the work area
Co\cem_walagincourt\SyncServertl 4tfaoisync_framework_instalisync_framework_nstallCD : ynchronizeriwebappsiTiogicintegrationtadminichangechangeadapter3B50508E5177 . File added to the work area
Colcem_walagincourt SyncServer | 4faoisyne_framewark_instalisyne_frameworl_nstalliCDimage\GenericChangeSynchranizertwebapps Tlogickiegration'adminichangechangeadapter 3850508E51 77 .. File added to the work area
Cricem_walagincourt SyncServertl 4tfooisync_framework_installsync_framework_installCD neri ynchronizerwebapps Tiogicitegrationtadminichangechangeadapter WBF30CCESES .. File added to the work area
Coicem_walagincourt SyncServer 4fasisyne_framewark_instalisyne_framework_stalliCDimage GenericC} gickte \gechangeadiapl 0BE31 .. File added 1o the work area
Cilcem_walagincourt SyneServertl 4tfooisyne_framework _installsync_framewark_nstallCD neri chronizertwehapps Tiogictegrationladminichangechangeadapter\761 J4FASFO9... File added to the work ares
C:\com_walagincourt SyncServertl 4tfaoisync_framework_instalisync_framework_nstallCD : \chronizertwebappsiTiogichtegration'adminichangschangsadapter 781 34FASFOS . File added to the work area
Colcem_walagincourt SyncServer 1| 4faotsyne_framewark_installsyne_frameworls_nstalliCDimage\GenericChangeSynchranizertwebapps Tlogickiegration'adminichangschangeadapter 781 4FASFO9... File added to the work area
Co\cem_walagincourt SyncServertl 4tfaoisync_framework_instalisync_framework_installCD neri \chronizertwebapps Tiogicltegration'adminichangschangeadapter8CCBA! DD3BA... File added to the work area
Coicem_walagincourt SyncServertl 2fasisyne_framework_installsyne_framework_nstalliCDimageiGenericC} gichteq gechangeadapter BCCEE1DD934... File added to the wark area
Colcem_walzgincourt SyncServertl 4tfooisyne_framewaork_instalisync_framework_nstallCD neri chronizertwehappsTiogicltegr ationtadminichangechangeadapter\aCCEE1 DDIBA... File added to the work arez
Co\cem_walagincourt\SyncServertl 4tfaoisync_framework_instalisync_framework_nstallCD : ynchronizerwebappsiTiogicintegrationtadminichangechangeadapterBF61 OCEAEF . File added o the work area
Colcem_walagincourt SyncServer | 4faoisyne_framewark_instalisyne_frameworl_nstalliCDimage\GenericChangeSynchranizertwebapps Tlogickiegration'adminichangechangeadapter\8F61 OCEA4SF .. File added to the work area
Cricem_walagincourt SyncServertl 4tfooisync_framework_installsync_framework_installCD neri ynchronizerwebapps Tiogicitegrationtadminichangechangeadapter\BF61 0CEASF . File added to the work area
C:\cem_walagincourt\SyncServer\l 4fooisyne_framewaorl_instalisync_framewark_instal\CDimage\GenericChangeSynchronizerwehappsTlogicltegrationladminichangechangeadapter\ChangeChang... File addzd to the work ares
Cilcem_walzgincourt SyneServertl 4tfooisyne_framewaork_instalisync_framewark_nstallCD neri chronizertwehappsTlogicltegr ationiadminichangechangeadapter\ChangaChang... File added to the work arez
C:\com_walagincourt SyncServertl 4tfaoisync_framework_installisync_framework_installCD \chronizertwebappsiTiogichtegration'adminichangschangsadaptericiear cache it  File added to the work area
yne Work Area returned 30 conflicts

Discard work area changes EE

Select this icon if you want to discard changes to specified files in your work area. Additionally, if
you choose to discard a directory, the directory and all of its members will be discarded from your
work area. In both cases, the file(s) and directory will be replaced in your work area with the latest
database version.

Keep work area changes @

Select this icon if you want to sync changes to a directory and file(s) in your work area with the
database. Note that this can result in new files because a file in your work area, but not in the
database will be added to the database.

Ignore files you do not want Synergy to control

If you see conflicts for files that you don't want to control, you can choose to ignore files by pattern

through the Show work area filters action ‘%j in the Sync Work Area section under the Actions
tab. Doing this sets filters to keep files with specified patterns from appearing as conflicts after you
perform a Sync Work Area operation.

If you set filters, you will need to perform another sync to refresh the output in the Work Area
Conflicts dialog box.
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How to work with multiple Synergy databases

If you have projects in more than one Synergy database, you should create a Repository Connection for
each one of them. You can use the Synergy Repository view to open projects from multiple databases.

If your project is connected to Synergy, the project name will be decorated with the project version and
Synergy Connection name.

How to use Eclipse Refactor

Eclipse provides a re-factor facility by which a change in a class/file name is automatically reflected in all the
affected classesf/files in the projects.

Rename

You should perform rename as a normal operation in Eclipse. This operation might need to
modify other files, as these may have references to the class defined by this file. In case of
renaming a folder, the package name has to be changed for the files contained in it. As a result of
this operation, all the files that need to be modified will be checked out automatically if they are
not checked out already.

Move

Move is used to change the package location of java classes. Move also affects the project files.
Therefore, dependent files must be checked out. The integration will automatically check out the
dependent files.

Rename Project

This operation does not affect any class files. The only file that gets modified is .project file. If
.project file is not checked out, the rename project operation will automatically check out this
file. The project is renamed in Eclipse only. This operation does not change the Synergy project
name.

Move Project

To move a project linked to Synergy, perform a Eclipse move operation on the project and provide
a new location for the project. Your project will be moved to this new location. This operation will
change the work area of the project in the Synergy repository.

How to use a version of a file/folder

1. On the workspace menu, select Replace With and then select Another Version... to bring up the
Replace dialog box.
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Select the version to replace with:
Version Status Cwner Task Relegse
BE 4 integrate com_root 1.0
Eﬂ 3 integrate com_root 1.0
Eﬂ 2 integrate com_root 1.0
Bg 1 integrate ccm_root 1.0
Replace ] [ Recommend ] [ Cancel

2. Select the version that you want to use.

3.  You can click Recommend to see which version of the object will be picked by the Update Members
operation.

4. Click Replace.

Note: To replace the current version of a file/folder with previous version, select Replace With and then
select Previous Version. If the selected file/folder has more than one predecessor, you will be prompted to
select one of the predecessors.

Bl Replace
Select a previous version to replace with:
Version Status Owner Task Release
B% 3.1.1 integrate cecm_root 1.0
B% 4 integrate cem_root 1.0
Replace ] [ Recommend ] [ Cancel

Note: You can also use Synergy History view to use a version of file/folder.

How to compare versions of a file/folder

1. On the workspace menu, select Compare With and then select Another Version... to bring up the
Compare dialog box.
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Select a version to compare with:

Version Status Owner Task Release
§E 3.1.2 working com_root 1.0
EE .11 integrate ccm_roat 1.0
EE 4 |ntegrate com_root

3 —
BE 2 |ntegrate CCm rnnt
BE 1 integrate ccm_roat 1.0

Compare ] [ Recommend l [ Cancel

2. Select the version that you want to compare with.

3. You can click Recommend to see which version of the object will be picked by Update Members
operation.

4. Click Compare. The compare results will be shown inside Eclipse.

Note: To compare the current version of a file/folder with previous version, select Compare With and then
select Previous Version. If the selected file/folder has more than one predecessor, you will be prompted to
select a predecessor to compare with.

Compare
Select a previous version to compare with:
Version Status Owner Task Release
Bg . 1.1 integrate ccm_root 1.0
Bg 4 integrate ccm_root 1.0
Compare ] [ Recommend ] [ Cancel

Note: You can also use Synergy History view to compare versions of a file/folder

How to check out a project hierarchy in Eclipse
1. Start the Project Check Out wizard.

a. You can start this wizard by clicking Check Out Project on the Synergy toolbar

b. You can also use the Synergy Repository View. Select the project version you want to check
out, and then click Check Out from context menu.
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2. To check out a project and its subprojects, select the non-modifiable project and the corresponding
version.

3. Select Also Check Out Subprojects.

4. Click Finish. The selected project and all its subprojects will be checked out and added to your
workspace.

How to open a project hierarchy in Eclipse
1. Start the Project Open wizard.

a. You can start this wizard by clicking Open Project on the Synergy toolbar

b. You can also use the Synergy Repository view. Select the project version you want to open
and then click Open Project from context menu.

2. To open a project and its subprojects, select the project and the corresponding version.
3. Select Also Open Subprojects.
4. Click Open.

How to check out more than one version of a project

This operation is useful when you have to work on more than one release of the same project. When you
check out a project, you specify a release and version. The project is then opened in Eclipse. To check out
more than one version of a project, all you need to do is to perform a normal project check out operation.
The project will be created in Eclipse with its name constructed using underscore (_) and project’s version.

For example, assume that Synergy has a non-modifiable project Px and its version is 1. When you perform
a checkout operation, Px is checked out to version 2. In Eclipse, its name will appear as Px. To work on
another release, you want to checkout this project again. This time, its version is 3. In Eclipse, this project
will be created as Px_ 3.

How to open more than one working version of a project

If you have more than one working versions of a project, you can open them all in Eclipse. The name of the
project is constructed using the convention Pr oj ect Name_Proj ect Ver si on.

For example, if you have the working versions Px- 1, Px-2, and Px- 3 of a project Px and you open
them in the order Px- 1, Px-2, Px- 3, the projects created in Eclipse will be Px, Px_2, and Px_3.

How to view the error log

The integration writes error information to Eclipse’s Error Log. To view these errors, perform the following
steps:

1. Bring up the About Eclipse SDK dialog box located in Help -> About Eclipse SDK.
2. Click Configuration Detail.

3. Click View Error Log.
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How to use context sensitive help

The integration provides context-sensitive help for different views and menus. To view the context-sensitive
help, select the view/menu and press the F1 key. A small pop-up window will be displayed containing
hyperlinks to the help page. Click on the hyperlink to view the details.

Context-sensitive help is available for:

- Synergy menu

« Select Task

Provides quick access to Synergy select task operation,
El Select Task
=l How to use Task-Based CM

= Create Task

Provides quick access to Synergy create task operation.
=l Create Task

=l How to use Task-Based CM

+ Complete Task

Provides quick access to Synergy complete task operation.
= Complete Task
= How to use Task-Based CM

= Show Task

Provides quick access to Synergy show task operation.
|=I Show Task Properties

=l How to use Task-Based CM

= Checkout Project
Chedks Qut Synergy project and adds to Workspace.
=l Chedk Out Project

 Open Project
Adds Synergy warking project to Workspace.
[Zl Open Project

- Synergy Repository View

Page 80 of 87



i Help 52

Related Topics
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VEE

Provides user friendly interface to Synergy Connection
management., Offers enhanced project management. Lse

this view to open and chedk out projects.

Create Synergy Connection
Set a Connection as Default
Clear Default

Modify Synergy Connection
Start Synergy Connection
Stop Synergy Connection
Delete Synergy Connection
Open Projects

Chedk Out Projects

TP TP (T TP (TP TP TP TP (TP I [P 17

Show in History View

- Synergy Task View

i@ Help 2

Related Topics
- About

View Modify Object Properties

Provides user friendly navigation to tasks assigned to
current Synergy user, Use this view to manage tasks and

associated objects,

Create Mew Task

Set a Default Task

Clear Default Task

Complete Task

View Modify Task Properties
View Modify Object Properties
Show in Histary View

TP T TR T TP TP (TP [T

refresh View

- Synergy Team Preference
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Related Topics

+ About

Lse the Team Preference to chanage the way
Integration works,

E General settings

Label Decorators Settings
Data Persistence

Project Wizard

E]
B
B
E cr Attributes

- Synergy History View

P Help 2 & = =0

Related Topics

+ About

Provides information about history of projects, files and
folders. It can also be used to view parallel versions,
Provides a visual compare and merge tool,

Open History View

Show Parallel Mode

Synergy History Settings

Select Sort Column and Sort Order
LIse Version

Compare Version

Manual Merge

Automatic Merge

Merge and Keep Current Version
Merge and Replace Current Version
Refresh

TP TP (7 TP (TP TP (TP TP (TP I [P 17

How to use Eclipse Team Project Sets - Export and Import

Eclipse provides a way to export a set of repository configured projects. The export operation results in a
text file which has a .psf extension. Other users can use this file later to import the same set of projects into
Eclipse. The import operation will check out projects if necessary. The checked out projects will have the
same baseline and release as the exported projects.

Export Team Project

1.  Use Workbench’s File menu or context menu to select Export.
2. Choose Team Project Set in the Export dialog box.
3. Click Next.
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From the Team Project Set dialog box, select the projects that you want to export and specify a
destination file. You can also select multiple projects.

Click Finish. For each selected project, the integration will export Synergy database information, project
name, project version, project status, project instance and project owner information. This information is
used during Team Import.

Import Team Project

1.

2
3.
4

Use Workbench’s File menu or context menu to select Import.

Select Team Project Set in the Import dialog box.

Click Next.

In the Team Project Set dialog box, specify the source file and click Finish.

The Integration will look for a Synergy Connection corresponding to the Synergy database information
contained in the import file. If you do not have such a connection, the integration will bring up the

Create Synergy Connection dialog box.

If you have more than one Synergy Connection corresponding to the Synergy database information
contained in the import file, the integration will prompt you to select a connection to be used for import.

‘4 Select Connection

Select Connection you want to use to import the project 'newproject1’,
Press 'OK for All' to use the selected Connection for imperting rest of projects in Team Project Set file.
Press Cancel if you rather create a new Connection.
Connection User Database Host
@ db3 demao Ym2Ycorndb 70db3 vmz2
@ dba ccm_root \itest\cemdb\trainings_g test
okforal || ok || cancel

In the Select Connection dialog box, choose a connection and press OK. Press OK for All if you want
to use the selected connection for rest of the projects in Team Project Set file.

For each project in the import file, the integration will try to open a working project that matches closely
to the project being imported. If there is more than one such working project, the Integration will prompt
you to select one.
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select Project P§|

fou don't have a working project in S¥YMERGY/CM which exactly matches the values
specified in Import Team Project Set file.

The Following projecks match closely.
If vwou would like to use one of the projects below, select it and click OF to open it.
If wou wauld rather check ouk a new prajeck, click Cancel,

| Project | Wersion | Skatus | Relzase
Y& brgtest 100 warking eclipse/301
Y& brgkest 23 warking eclipse/301

Ik | Cancel

9. In the Select Project dialog box, select the appropriate project and press OK. The project will be
opened in your workspace. Press Cancel if you would rather check out a new project.

10. If you pressed Cancel in the Select Project dialog box, the integration will bring up the Project
Checkout dialog box. Check out the appropriate project to open in your workspace.

How to pick a date

The Integration provides a date control which can be used to select a date in a format accepted by the
Integration. The local date format is accepted throughout the integration.

Select Date §|

Sun |Mon | Tue Wed |[Thu (Fri | Sat
1 2

3 4 5 & 7 g 9

m 11 12 13 14 |15 |16

17 |18 |19 (20 |21 |22 |23

24 |25 |26 |27 28 |29 |30

31

The date control can be invoked by clicking the Browse button from the following dialog boxes.

e Create Task dialog box

e Task Properties dialog box

e Synergy History View Settings dialog box

To pick a date from the date control, select the desired date and double click.
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Tracing and Debugging

The Eclipse platform provides a mechanism for tracking the activity of your plug-in at runtime without full
debugging. It allows you to use tracing flags that will cause tracing information to be written to the log file.
This log file is useful in debugging the plug-in.

Use the following steps to trace the plug-in.

1.

Create a text file named .options and save it into the directory where your
eclipse.exe file is located. For example, this could be C: /eclipse34/eclipse if
this is the directory where eclipse.exe is.

Enter the following contents into the file:

com.ibm.rational.synergy.integration.connection/debug=true

com.ibm.rational.synergy.integration.connection/debug/filter=*

The flag fi | t er =* shows that all the classes will be traced. If you want to trace a particular class,
replace * by that class name.

Restart Eclipse in debug mode. If you are using a shortcut, your target will be:
C:\eclipse34\eclipse\eclipse.exe —debug. Mirror the Console View output to the
command line console using —consol el og option.

The output will be written to this console.

Conversion Process for Eclipse 1.0 projects

If you have Eclipse 1.0 projects controlled in Synergy, you need to convert them into Eclipse 3.3 projects.

The steps below describe how to perform this conversion. Use Synergy and the IBM Rational Synergy for
Eclipse Integration 4.2.0.

a. Using Eclipse 3.3 get the project into your work space. You can use Synergy toolbar button
Open Project or Check Out Project.

b. The project properties stored in .vcm_meta file will be imported into .project file. Rebuild the
project. If you encounter compilation errors, consult the Eclipse online help to fix these errors.

c. Select or create a default task.

d. Remove the . vem net a file, as it is no longer needed. Look for messages in Console view.
A Message box will appear in the next session to remind you to remove .vcm_meta. You can
remove this file from your project. You can also remove any other files that you don’t need.

e. Add all the newly added files to Synergy using Add Uncontrolled Files option on the Team
menu.

f.  Complete the task. Your project is converted to an Eclipse 3.3 project and is now under
Synergy control.

Contacting IBM Rational Software Support
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If the self-help resources have not provided a resolution to your problem, you can contact IBM® Rational®
Software Support for assistance in resolving product issues.

Note: If you are a heritage Telelogic customer, a single reference site for all support resources is
located at http://www.ibm.com/software/rational/support/telelogic/

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active Passport Advantage®
software maintenance agreement. Passport Advantage is the IBM comprehensive software licensing and
software maintenance (product upgrades and technical support) offering. You can enroll online in Passport
Advantage from http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

e Tolearn more about Passport Advantage, visit the Passport Advantage FAQs at
http://www.ibm.com/software/lotus/passportadvantage/brochures fags quickguides.html.
e  For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you must
additionally:

e Be aregistered user on the IBM Rational Software Support Web site. For details about registering,
go to http://www.ibm.com/software/support/.
e Be listed as an authorized caller in the service request tool.

Submitting problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are asked to
supply a severity level. Therefore, you need to understand and assess the business impact of the
problem that you are reporting.

Use the following table to determine the severity level.

Severity Description

The problem has a critical business impact: You are unable to use
1 the program, resulting in a critical impact on operations. This
condition requires an immediate solution.

This problem has a significant business impact: The program is

2 usable, but it is severely limited.
The problem has some business impact: The program is usable,
3 but less significant features (not critical to operations) are

unavailable.

The problem has minimal business impact: The problem causes
4 little impact on operations or a reasonable circumvention to the
problem was implemented.

2. Describe your problem and gather background information. When describing a problem to IBM, be as
specific as possible. Include all relevant background information so that IBM Rational Software Support
specialists can help you solve the problem efficiently. To save time, know the answers to these
questions:
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o What software versions were you running when the problem occurred?
To determine the exact product name and version, use the option applicable to you:
o Start the IBM Installation Manager and select File > View Installed Packages. Expand a
package group and select a package to see the package name and version number.
o  Start your product, and click Help > About to see the offering name and version number.
What is your operating system and version number (including any service packs or patches)?
Do you have logs, traces, and messages that are related to the problem symptoms?
Can you recreate the problem? If so, what steps do you perform to recreate the problem?
Did you make any changes to the system? For example, did you make changes to the hardware,
operating system, networking software, or other system components?
e Are you currently using a workaround for the problem? If so, be prepared to describe the
workaround when you report the problem.
3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM Rational
Software Support in the following ways:
e Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational/support/ and in the Rational support task navigator, click
Open Service Request. Select the electronic problem reporting tool, and open a Problem
Management Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support Assistant. For more
information, go to http://www.ibm.com/software/support/isa/fag.html.

e By phone: For the phone number to call in your country or region, go to the IBM directory of
worldwide contacts at http://www.ibm.com/planetwide/ and click the name of your country or
geographic region.

e Through your IBM Representative: If you cannot access IBM Rational Software Support online or
by phone, contact your IBM Representative. If necessary, your IBM Representative can open a
service request for you. You can find complete contact information for each country at
http://www.ibm.com/planetwide/.
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